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Using This Manual

Who Should Use This Manual
This manual describes how to use Harmony release 1.2 calibration
software. It also contains reference material about tonal calibration. Use
this manual with the accompanying Harmony reference documentation
for your specific workflow.
This manual is intended for prepress operators responsible for calibrating
tonality.
This manual assumes that:
You have a working knowledge of prepress operations.
You are familiar with the use of a personal computer running the Windows
operating system.
All the hardware, software, and network components of your Creo system
are installed, configured, and operating correctly.
Files submitted to the Creo system are free of common errors usually dealt
with during preflight, such as missing fonts and PostScript errors.

Conventions Used in This Manual
This section describes the fonts, terminology, and symbols used in this
manual.

Workflow-Specific Text Indicators
Some information in this manual applies only if you have a particular
workflow. In these cases, the name of the workflow is indicated in the
margin.
The workflow-specific indicators in this manual are:
Copydot

Indicates information for those using Harmony with
Creo Copydot Toolkit only.

Delta

Indicates information for users with a Delta workflow
only.

iMPAct

Indicates information for users with an iMPAct
workflow only.

Conventions Used in This Manual

xi

Prinergy

Indicates information for users with a Prinergy
workflow only.

Spectrum

Indicates information for users with a Spectrum
digital halftone proofing workflow only.

Fonts
Frutiger bold is used to refer to buttons and other items in a dialog box, file

names, folders, menu names, and menu commands.
Minion Italic is used to refer to other chapters in the manual, book titles,
and titles of other manuals.
Frutiger is used for figure and table captions.
/HWWHU*RWKLF is used for messages on your computer screen and for

information that you must type.
SMALL CAPS is used

for a key or key combination on your keyboard.
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Terminology
Clear

Place the mouse pointer over the check box for the
specified option, and click the left mouse button so
that the X or check mark is removed from the check
box.

Click

Place the mouse pointer over the specified option or
button and press and release the left mouse button.

Double-click

Place the mouse pointer over the specified option or
button and quickly press and release the left mouse
button twice.

Drag

Hold down the left mouse button while moving the
mouse and release the button.

Enter

Type the information and press the ENTER or RETURN
key.

Point

Position the mouse pointer over a submenu or menu
command. For example, point to the File menu.

Press

Press the specified key or key combination on your
keyboard, for example, press CTRL+ALT+DEL.

Right-click

Place the mouse pointer over an area of the
application window, and then press and release the
right mouse button to display the shortcut menu. For
more information about using shortcut menus, see
your Windows documentation.

Select

Place the mouse pointer over the check box for the
specified option, then click the left mouse button so
that an X or check mark appears in the check box.
Or:
Place the mouse pointer over the specified box or
button, and then click the left mouse button.

Type

Type the information. Do not press the ENTER or
RETURN key.

PDF Document

xiii

Symbols
Attention: This symbol alerts you to things that may cause loss of data or
damage to your computer hardware.

Important: This tells you about things that may cause process delays or reduce
functionality, reliability, or quality.

Note: A note provides additional information that you may need to consider.

Tip: This symbol draws attention to information that can help you perform a
task more quickly or easily.

The reference symbol tells you that related information on the topic is available
in other Creo documents.

PDF Document
This manual is also provided in PDF (Portable Document Format).
The PDF document can be used for online viewing and printing using
Adobe Acrobat Reader. When printing the manual, please print the entire
manual, including the copyright and disclaimer statements.
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What Is Harmony?
Harmony software lets you calibrate output in a digital prepress workflow.
You can use Harmony to create, apply, and manage calibration curves.
Calibration curves control tonal reproduction on press and are applied
when the digital file is rasterized by your output raster image processor
(RIP). By controlling tonality in the print reproduction process, Harmony
lets you achieve the presswork quality you want without adjusting the
press.
Copydot

Depending on your workflow, calibration can be applied to continuous
one representation of tints and to copydot (screened) data.
Harmony lets you match your output with an output sample you choose,
called a target. It also lets you calibrate proofs imaged with proofing
devices such as the Trendsetter Spectrum digital halftone proofing option.
Harmony has two components:

•

the Harmony application, which lets you create, edit, import, and
export curves

•

the Harmony database, which stores the curves that you create, edit, or
import

Benefits of Using Harmony
Most other calibration tools are built to calibrate film. Film calibration
assumes that you want to linearize the curve, which means output the same
tint percentage as was input. In other words, these tools assume a linear
target and don’t let you to enter a different target.
Harmony can be used to calibrate film (you enter a linear target to achieve
film calibration); however, it may also be used to calibrate plates, proofs,
and press sheets. For plate, proof, and press sheet calibration, a linear
target curve is not usually desirable, so Harmony lets you enter a different
target.
By controlling tonal reproduction and incorporating tone value increase as
a fundamental component of the printing process, Harmony gives you
accurate control of the product you sell. It also gives you the flexibility to
tailor the result to meet different customer expectations.
For more information about calibrating various output types (for
example, film, plate, or press sheet), see Choosing Which Output Type to
Calibrate on page 14.

Why Calibrate?

3

Limitations of Harmony
Harmony can be used only with RIPs that read its database format.
See also Limitations of Tonal Calibration on page 3.

Why Calibrate?
You need to calibrate to control the tones on the press sheet. Tonal values
can change during print reproduction. This change is called tone value
increase; it is a normal part of the print reproduction process.
In a halftone workflow, tone value increase occurs because the size of the
halftone dots changes during the halftone reproduction process. This
change in the size of halftone dots (tone value increase) is called dot gain.
Controlling tones using calibration means that you can manipulate the
exact size of the dots on the printing plates so that tone saturation and gray
balance are controlled on the press sheet.
Tonal calibration can account for:

•
•
•
•

type of plate or film used
type of paper stock used for printing
type of dot shape used
type of screening used—for example, stochastic or conventional, lines
per inch (lpi), and dots per inch (dpi)

Important: If you are using computer-to-plate technology, for example, a
Trendsetter, do not adjust the laser exposure to increase or decrease tints.
Adjusting laser exposure is not tonal calibration and will affect the run length of
the plate.

Limitations of Tonal Calibration
You cannot use tonal calibration as a substitute for stable operating
conditions. Operating conditions must be controlled as a separate process.
In fact, without a stable operating environment, you cannot achieve
accurate tonal calibration.
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Press operating conditions that must be stabilized are:

•
•
•
•
•
•

appropriate ink tack
correct ink-water balance
good blanket conditions
correct ink densities
registration
appropriate humidity and temperature

As well, tonal calibration cannot account for the color shift or tone break
that occurs when halftone dots join. All conventional screens cause a jump
in color at a certain tint when the ink of adjacent dots begins to touch. You
cannot remove this jump by calibrating. For example, a Euclidean dot
jumps at 50% because its shape causes all four sides to join at that tint
percentage.

When Should You Calibrate?
If you are not happy with your current tonal reproduction, you should
calibrate.
Once you have established a standard set of calibration curves that work
well, you only need to add or adjust curves when something in your
process changes or when your printing objectives (your targets) change.
For example, your printing operation has one target and uses a calibration
curve that lets you achieve that target on all your work. However, one of
your customers likes the fuller printing achieved with a negative film
workflow. To satisfy this customer using computer-to-plate technology,
you need to create a new target curve and derive a new calibration curve to
meet that target. You can still retain the previous target curve and its
associated calibration curve for other work.
To use Harmony successfully in your workflow, it is helpful if you
understand the theory of tonal calibration.

What Is Tonal Calibration?
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What Is Tonal Calibration?
This section is included to help you understand the idea behind Harmony
calibration. Having a basic knowledge of tonal calibration may help you
decide when and how to create and modify curves, as well as troubleshoot
problems.

What Is Tonality?
Tonality in printing is the progression of tints from blank paper to solid ink
for each color in a printing job. You can determine tonality by measuring a
series of tint patches—ranging from the highlights to the shadows—on
your output. The measurement you take for each tint is the percentage of
light each tint patch absorbs—for example, 0% tint for blank paper (no
light absorbed) or 100% tint for solid ink (all light absorbed). This
measurement is called the tonal value.
Tonal value describes all visual representations of tints, including
continuous tone tints and halftone tints. Tonal value on halftone output is
also called effective dot area or Murray-Davies dot area.

What Is Tone Value Increase?
Tonal values can change during the print reproduction process so that the
tonal values on your final output are greater than the tonal values you
expected. This change is called the tone value increase. Tone value increase
is a normal part of printing, and there are a number of reasons why tone
value increase happens during the print reproduction process. Tone value
increase on halftone output is called dot gain.
For more detail on why and where tone value increase happens, see Tone
Value Increase in Digital Tonal Reproduction.

Tone Value Increase in Digital Tonal Reproduction
In a digital workflow, tone value increase happens when a digital file is
turned into an image on a press sheet or proof. The result is that the tint
values specified in the digital file do not match the tonal values on your
output. By using Harmony to calibrate tonality, you can control the tonal
values on your output and achieve desired results under a variety of
printing conditions.
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To fully understand why you need to calibrate, you must understand how
the change between the tint percentage specified in the digital file and the
tonal values on the press sheet happens during tonal reproduction. In
other words, you need to understand how and where tone value increase
happens in this process.

Overview of Digital Tonal Reproduction
The digital tonal reproduction process involves a number of steps. Figure 1
illustrates these steps.

Expose film
to plate
Image
Film
output

Image

Screen

Digital file

Print

Bitmap
Plate
output

Press sheet
output

Figure 1: Digital tonal reproduction

The steps in the tonal reproduction process are:
1.

You start with a digital file (for example, PostScript or PDF). In the file,
all tints are assigned a continuous tone percentage value between 0 and
100 that corresponds to a specifically sized halftone dot.

2.

The file is turned into a bitmap by the screening engine of the RIP.
The RIP converts the file by reading the percentage values defined in
the file and creating a screen of halftone dots, each with a tint
percentage value. For example, 50% means that half percent of the
halftone cell area is covered by the halftone dot.
Halftone dot
Halftone cell

Figure 2: Halftone cell

What Is Tonal Calibration?
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3.

The bitmap is output to plates or proofs. In this step, each halftone
dot is imaged on the plate or proof using a series of laser spots.
Note: If you are not using computer-to-plate technology, the bitmap is first
imaged to film, and then the film is exposed on the plate to transfer the
image to the plate.

4.

A printing press is used to transfer the image from the plate to the
press sheet.

When Tone Value Increase Occurs in Digital Tonal
Reproduction
Tone value increase happens in the process that converts a digital file to a
visual tint rendered by ink on paper (shown in Figure 1 on page 6). Tone
value increase is the absolute, not relative, increase in tonal value. For
example, if a 50% tint specified in the file produces a 69% tonal value
(effective dot area) on the press sheet, the overall tone value increase
(dot gain) is 19%.
The graphical relationship between the tint values specified in the digital
file and tonal values or effective dot area on the press sheet or proof is
called the print characteristic. Figure 3 shows this relationship.

Tone value
increase (%)

Tonal value or
effective dot
area (%) on
the press sheet

Linear output
(tint value specified in digital file
equals tonal value on press sheet)

Tint value (%) specified
in the digital file

Figure 3: Print characteristic

On halftone output, there are two types of tone value increase (dot gain):
physical dot gain and optical dot gain. Tonal value or effective dot area—
that is, the perceived tint on the press sheet or proof—includes both
physical and optical dot gain. It is a measure of the amount of light trapped
by the dot on the sheet, compared to that trapped by solid ink.
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Physical Dot Gain

Physical dot gain means there is a change in the physical size of the dots
during tonal reproduction. Changes in the physical size of the dot can
happen at three points in the process:

•
•
•

imaging and processing the film or plate
contacting and processing the plate in a film workflow
printing on press

During the process of imaging to plate, either directly from the file or from
film, a small change in dot size can happen. Typically, contacting negative
film results in physical dot gain and contacting positive film produces
physical dot loss.
Note: Physical dot gain (or loss) is minimal with Creo-developed thermal laser
head or HRX green head technology on most plate types.

Changes in the physical dot size occur on press as ink and water are
transferred to the plate, as ink is transferred to the blanket and then to the
paper, and by the pressure of subsequent printing units.
Tint:

50%

50%

53%

69%

Digital file
tint

Bitmap
tint

Plate output
tint

Press sheet
output tint

Screen
Tone value increase 0%
(dot gain):

Image

Print

3%
(physical
dot gain)

19%
(physical and
optical dot gain)

Figure 4: Example of tint value changes

For example, in Figure 4 on page 8, the overall tone value increase dot gain
(from tint specified in the digital file to the press sheet output tint) is 19%,
and the tonal value on the press sheet is 69% (from a 50% tint specified in
the file).
Optical Dot Gain

Optical dot gain is the increase in the amount of light trapped by a dot,
beyond the physical size of the dot. This increase happens because light
striking white paper may be diffused by the paper and subsequently
absorbed by a nearby ink dot, rather than leave the paper. The absorption
of this diffused light makes the dots appear effectively larger than their
physical size.

What Is Tonal Calibration?
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Under a microscope, the physical size of the dot corresponds directly to the
bitmap tint percentage plus the physical dot gain. To the eye (or if
measured with a densitometer), the amount of light corresponds to a dot
area that is effectively greater than the physical dot. The overall lightabsorbing effect of the dot, by virtue of its physical size and optical dot
gain, is the tonal value.
Optical dot gain

Dot

Cross section of dot
Physical dot
Light absorbed by dot on paper
(or plate)

Figure 5: Tonal value

Does Harmony Calibration Remove Tone Value Increase?
A common misconception is that the purpose of calibration is to remove
dot gain or tone value increase.
Harmony does not remove dot gain from the printing process because, as
explained above, both physical dot gain and optical dot gain are part of the
halftone reproduction process and cannot be removed.
What Harmony does do is compensate for the dot gain that you are
currently getting. Harmony does this by adjusting the size of dots imaged
on the plate, digital halftone proof, press sheet, or film. The RIP makes an
adjustment, based on the tint value specified in the file, so that the desired
result is reproduced on your final deliverable. See How You Use Harmony.
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How You Use Harmony
Harmony lets you:

•

create calibration curves that are applied to your output. See Creating
Curves.

•

import a predefined calibration curve that is applied to your output.
For more information on importing calibration curves, see Importing and
Exporting Harmony Curves on page 92 or the Harmony reference
documentation for your specific workflow.

•

manage your Harmony database. For more information on managing
your Harmony database, see the Harmony reference documentation
for your specific workflow.

Creating Curves
If you want to create your own calibration curves, you must first define
your printing objective, that is, what you want to achieve on press. This is
called the target curve. For example, if calibrating to a press sheet, your
target may be a proof or the previous press run. If calibrating to plate, your
target may be a plate that achieves good printing. You measure the target
sample and enter the dot area (tonal value) for the tints on the target curve
graph in Harmony.
Then, you characterize the output you are producing now, called a current
curve. You measure the current sample and enter the dot area (tonal value)
for the tints on the current curve graph in Harmony.
Finally, you match the target curve (what you want to achieve) and the
current curve (what you are achieving now). Harmony uses the dot area
(tonal value) information you entered in the target and current curve
graphs to create a derived calibration curve.
Based on the tints specified in your digital file, Harmony determines the
adjustment needed to achieve the target. The definition of this change is
the derived calibration curve. Harmony stores each of these curves in the
Harmony database, as well as the link between the calibration curve and
the target and current curves from which it was derived.

How Harmony Creates a Calibration Curve
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How Harmony Creates a Calibration Curve
The basic principles of Harmony are:

•
•

Tone value increase (dot gain) exists in the print reproduction process.
Under stable operating conditions, a press has a certain print
characteristic—that is, a press produces consistent tone value increase.
For example, each time a 45% tint is specified in the file, a press
produces a tint that measures 58%.

Knowing these principles, Harmony calibrates by applying a different tint
when the digital file is RIPed, rather than the tint specified in the file. The
tint Harmony applies during RIPing is called a calibrated tint.
For example, you want a 45% tint specified in the file to produce a 70% tint
on press; however, a 49% tint produces a 70% tint on press. You could
adjust the press to change the print characteristic, but this is costly and
time-consuming. The only way to change your results on press without
altering the press is to input a different tint value at the RIP. In other words,
by substituting a 49% tint, when a 45% tint is specified in the file, prior to
screening, Harmony lets you achieve a 70% tint on press without adjusting
the press.
Harmony determines which calibrated tint should be substituted by
comparing the number pairs for the target and current curves you want to
link together to create a calibration curve. The calibration curve it creates
is a graph of the tint specified in the digital file and the calibrated tint that
should be substituted.
Figure 6 shows that Harmony performs the following functions:

•

Finds the same tonal value percentage on the final output (output tint)
for both the current and target curves—in this case, 70%.

•

Determines how to compensate for the current tint to achieve the
target tonal value on press—in this case Harmony must input a 49%
tint to the RIP every time a 45% tint is specified in the incoming digital
file.

•

Builds a calibration curve that says: every time a 45% tint is specified in
the file, substitute a 49% tint at the RIP. By substituting a 49% tint,
given your print characteristic, a 70% tint appears on the final output.

The original digital file still says a 45% tint, but you end up with a 70% tint
on the final output. Your target is achieved.

12
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Output tint
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Digital file tint

Derived Calibration

Figure 6: How Harmony derives calibration curves

This example describes a current response that is uncalibrated. If the
current response was measured from calibrated output—that is, a
calibration curve was applied in producing plates for the current curve
sample—Harmony will consider the calibration used previously and
adjust the substitution accordingly.
For more information about using a calibrated current response, see Using
Calibrated Data on page 84.

Does Harmony Calibrate Color?
While Harmony is not a color management system, you can use it to create
color-specific calibration curves that will be saved together as a CMYK
Curves curve set. See Curve Sets on page 27.
When color-specific calibration is specified, a curve is created for each
process color (cyan, magenta, yellow, and black).
The black calibration curve is applied to all spot colors, unless you create
calibration curves for your spot colors. If you define spot color calibration
curves, color-specific calibration curves are applied to process colors, and
spot color calibration curves are applied to spot colors. For more
information about spot color curves, see Curve Sets on page 27.

Does Harmony Calibrate Color?
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When to Use Color-Specific Curves
Spectrum

Color-specific curves are an advanced feature of Harmony. Always use
color-specific curves when making proofs using the Trendsetter Spectrum
digital halftone proofing option or the Proofsetter Spectrum digital
halftone proofer.
Color-specific curves are also useful for:

•

correcting a significant gray balance problem
If your neutral three-color gray tints show a gray imbalance by
displaying a significant hue or not matching the corresponding black
screens, you need a CMYK Curves curve set to separately adjust your C,
M, and Y colors to produce a neutral grayscale. See Adjusting for Gray
Balance on page 96.

•

tailoring the film calibration and plate exposure to each separation
In other words, if the relative dot gain between press and proof varies
from color to color, you can calibrate each separation. For example, if
your press prints black heavier than other colors, you may want a
separate curve for black that accounts for the greater tone value
increase.

If you are not creating proofs on a Creo-developed Spectrum output
device, you usually need only one curve for all colors for the following
reasons.

•

Although the absolute dot gain characteristics are unique for each
separation, the resulting calibration curves are similar and apply the
same corrections to each separation.

•

A One Curve curve set is easier to maintain and update, so consider
carefully whether color-specific curves will add value to your printing.

If, in your conventional film workflow, you did not make film or plates
differently for each separation, you shouldn’t need to calibrate each
separation using color-specific curves in a digital workflow.
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How Many Calibration Curves Do You Need?
The number of calibration curves you need to create depends on many
factors. Depending on your situation, you may need one calibration curve
or many calibration curves.
Important points to consider are:

•

For current curves, remember that the plate type, screen type and
ruling, dot shape, ink, paper, and press can all have different effects on
tonal reproduction. Multiple curves may be required to account for the
role each factor plays in tonal reproduction.

•

For target curves, remember that proofing and print expectations will
determine how many curves you produce. For most, one target will be
enough. For others, a different target may need to be produced for each
type of proofing device and maybe even for different customers.

•

Each combination of target and current curve that you link together
will produce a different derived calibration curve (or transfer
calibration curve of derived origin).

Choosing Which Output Type to Calibrate
When you create a current or target curve, you must specify the output
type you want to calibrate. Harmony lets you calibrate three output types:

•
•
•

Film
Paper—includes both the printed result and proofs
Plate—includes flexography

You must specify the output type you choose in the Type box when setting
target curve and current curve properties. See Setting Target Curve
Attributes on page 79 and Setting Current Curve Attributes on page 81.
You must also use this output type when measuring current and target
samples. For example, if you want to calibrate the final result on press,
select Paper in the Type box, and obtain current sample measurements
from a press sheet and target sample measurements from a press sheet,
proof, or industry standard.
For more detail on target and current samples, see Chapter 4, Acquiring
Target and Current Samples.

Choosing Which Output Type to Calibrate
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We recommend choosing the same output type as your final deliverable. In
general:

•

A printing shop that produces press sheets and proofs should calibrate
Paper.

•

A shop that produces film should calibrate Film.
Usually film calibration linearizes film output—that is, it ensures that
the physical dot on film is the same size as the tint value specified in the
digital file you input. In this case, your target curve is simply a straight
line.
Note: If you image film using a Creo-developed output device with a thermal
head, you don’t need to calibrate for linear film because Creo SQUAREspot
thermal technology produces accurate linear results. In this case, simply
specify straight lines for both the current and target curves.

•

A trade shop that produces plates can calibrate either Paper or Plate.
For customers that you work closely with, you may want to calibrate the
final result on their press rather than the plate. In this case, select Paper.

The advantages of selecting Paper rather than Plate or Film are:

•
•

Plates can achieve different results on different presses.
It is the most accurate way to reproduce desired tones on press because
paper calibration accounts for dot gain (tone value increase) in all the
steps of tonal reproduction, including optical dot gain on paper.

If you decide to calibrate plates, select a plate that produces acceptable
printing as your target. This target can be used to recalibrate when changes
occur in the platemaking process. For best results, use the same plate type
for your current sample as you plan to use for the final deliverable.
See Selecting Your Output Type on page 60.
Note: If you image plates using a Creo-developed output device with a thermal
head, you don’t need to calibrate for linear plates because Creo SQUAREspot
thermal technology produces accurate linear results. In this case, simply specify
straight lines for both the current and target curves.
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Tools Required
Hardware and Operating System
Harmony can be installed on an Intel or Alpha computer using any of the
following operating systems:

•
•
Prinergy

Windows NT 3.51, NT 4.0, or higher (recommended)
Windows 95

You will also need a Local Area Network (LAN) if your Harmony database
and application are not installed on the same computer.
For more information about hardware and operating system requirements, see
the Harmony reference documentation for your specific workflow.

Measuring Device
You will need a measuring device, such as a densitometer, strip reader, or
plate reader, to measure the tints on your target and current output
samples.
You can use various types of measuring devices with Harmony to calibrate
tonality. Different types of measuring devices measure different attributes
affecting tonality. Make sure you select a measuring device that is
appropriate for the type of calibration you are using Harmony for.

Reflection Densitometers
Reflection densitometers illuminate the medium and measure the amount
of reflected light. The illuminating or reflected light is filtered to
discriminate among cyan, magenta, yellow and black colorants. If you use
a reflection densitometer in dot area mode, the device can measure the
effective dot area (EDA or optical dot area) of both halftone screens and
continuous tone tints. Different filter standards—for example Status A or
Status T—will give you different readings from the same measured sample,
so make sure that the measuring instrument and filter type you use are
consistent when you create curves.
Note: If your measuring device has a Yule-Nielson factor, do not adjust it. Leave
the Yule-Nielson factor at 1.

Use a reflection densitometer to measure solid density and effective dot
area on paper stock.

Tools Required

17

Transmission Densitometers
A transmission densitometer illuminates the medium you are measuring
from one side and measures the amount of light transmitted to the
medium’s other side. You typically use a transmission densitometer to
measure lithographic film, so these devices do not have color filters. If you
use a transmission densitometer in dot area mode, the reading you get
expresses the amount of light absorbed by a tint patch as a percentage of
the amount of light absorbed by a fully exposed patch of film. This is a
reasonably accurate measurement of the physical size of halftone dots on
film, because film exhibits minimal optical dot gain.
Use a transmission densitometer to measure physical dot area (PDA) on
lithographic film.

Spectrophotometers
A spectrophotometer illuminates the medium and measures the amount
of reflected light. The reflected light is separated into many narrow spectral
bands, and each band is measured separately.
Some spectrophotometers are capable of adding these spectral
measurements together in various proportions to simulate standard
densitometer filters and calculate effective dot area. These devices are often
called spectrodensitometers. In addition to the capabilities of
densitometers, spectrophotometers can also express color as LAB and
other values.
Use a spectrophotometer or spectrodensitometer in dot area mode (like
you use a reflection densitometer) to measure solid density and effective
dot area on paper stock.

Strip Readers
Strip readers are either densitometers or spectrophotometers that
automate the process of measuring tints. Strip readers measure the same
characteristics as hand-held densitometers and spectrophotometers.

Dot Meters
Dot meters illuminate the medium and take a picture with a chargecoupled device (CCD) camera. The dot meter analyzes the resulting image
to determine the physical dot area and screening characteristics of halftone
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dots, rather than the light-absorbing properties of the tint patch. Dot
meters measure reflective media. Some dot meters can also measure
transmissive media.
Use a dot meter to measure physical dot area on plates and film.

Densitometers, Spectrophotometers, and Harmony
Harmony supports densitometer input through the serial port on your
computer. You connect your densitometer to the computer’s serial port
and take tint measurements that Harmony can automatically detect and
use.
Harmony comes preconfigured for a number of densitometers. You select
the densitometer brand and model using the Preferences menu. If the
densitometer you use is not listed in this menu, you need to specify the
characteristics of your instrument in the densitometers.cfg file located in
the Harmony folder.
For more information on configuring your densitometer for Harmony, see
Appendix C, Setting Up Your Densitometer.

Strip Readers and Harmony
Harmony supports automatic strip reader input through the serial port on
your computer. You connect your strip reader to the computer’s serial port
and take strip measurements that Harmony can automatically detect and
use.
Harmony comes preconfigured for a number of strip readers. You select
the strip reader brand and model using the Preferences menu.
For more information on setting up your strip reader for Harmony, see
Appendix C, Setting Up Your Densitometer.

Dot Meters and Harmony
Harmony supports dot meter input through the serial port on your
computer. You connect your dot meter to the computer’s serial port and
take plate measurements that Harmony can automatically detect and use.
Harmony comes preconfigured for a number of dot meters. You select the
dot meter brand and model using the Preferences menu. If the dot meter
you use is not listed in this menu, you need to specify the characteristics of
your instrument in the densitometers.cfg file located in the Harmony
folder.

Tools Required
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For more information on configuring your dot meter for Harmony, see
Appendix C, Setting Up Your Densitometer.

Tint Bar
Each output sample you use needs to have a tint bar from which tints can
be measured.
Test forms and imposition marks with calibrated and uncalibrated color
tint bars are provided with Harmony. The calibrated tint bar allows the
appropriate calibration curve to be applied to it; the uncalibrated tint bar
does not allow any calibration curve to be applied to it.
We suggest adding the calibration marks to all impositions. By doing this,
you will not need to do a separate press, plate, or film run to measure your
current response.
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Starting Harmony
In most workflows, you can start Harmony from the Windows Start menu.
To start Harmony using Windows 95 or Windows NT 4.0:

½ From the Start menu, point to Programs, then point to Harmony, and
select Harmony.
To start Harmony using Windows NT 3.51:

½ From the Harmony program group, double-click the Harmony icon.

In some workflows, you can also start Harmony from your workstation
software.
For more information, please see the Harmony reference documentation
for your specific workflow.

Harmony Application Window
When you start Harmony, the application window displays. The
application window is where all Harmony processing is done.
Menu bar

Toolbar

Harmony
database
window

Status bar

Figure 7: Harmony application window

Harmony Application Window
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Menu Bar
The menu bar is located in the top of the window. All menu commands are
described in this manual in the context of the task in which you use them.
For an overview of the menus, see Appendix A, Menus.

Shortcut Menu
You can click your right mouse button on an item to display a shortcut
menu that contains common commands you can use on the item. For
example, by right-clicking a curve in the Harmony database window, you
can open, copy, or delete that curve.

Toolbar
The toolbar is located at the top of the window, just below the menu bar.
All of the tools in this bar are described in the context of the task in which
you use them.
For an overview of all tools, see Appendix B, Toolbar.

Hiding and Displaying the Toolbar
If you don’t want to use the toolbar, you can hide it from display.
To hide or show the toolbar:

½ From the View menu, select Toolbar.

If the toolbar was in view, it is now hidden, and the check mark next to
Toolbar no longer displays.
If the toolbar was hidden, it now displays, and a check mark appears
next to Toolbar.
Each time you select Toolbar, it is displayed or hidden.
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Status Bar
The status bar is located at the bottom of the window. The status bar
provides messages about the current action being performed.

Hiding and Displaying the Status Bar
If you don’t want to use the status bar, you can hide it from display.
To hide or show the status bar:

½ From the View menu, select Status Bar.

If the status bar was in view, it is now hidden, and the check mark next
to Status Bar no longer displays.
If the status bar was hidden, it now displays, and a check mark appears
next to Status Bar.
Each time you select Status Bar, it is displayed or hidden.

Harmony Database Window
When you save a current, target, or calibration curve, it is stored in the
Harmony database. The Harmony database window displays all of the
curves saved in the opened Harmony database. It also displays the
properties of each curve, and, for calibration curves, whether the curve is
enabled for selection by the RIP.
For more information about the Harmony database, see the Harmony
reference documentation for your specific workflow.

Types of Curves
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Hiding and Displaying the Harmony Database Window
If you don’t want to see the Harmony database window, you can hide it
from display.
To hide or show the Harmony database window:

½ From the View menu, select Curves Database.

If the Harmony database window was in view, it is now hidden. The
check mark next to the Curves Database menu command no longer
displays, and the toolbar button is not selected.
If the Harmony database window was hidden, it now displays. A check
mark appears next to the Curves Database menu commend, and the
toolbar button is selected.

Types of Curves
There are three general types of Harmony curves:

•
•
•

target curves
current curves
calibration curves

r
r

derived
transfer

All target, current, and calibration curves that you save in Harmony are
stored in the Harmony database. However, only the calibration curves in
the Harmony database are selected by the RIP and applied to files to
produce the desired result. In other words, only calibration curves are used
for tonal calibration in the print reproduction process.
Note: A calibration curve must be enabled to be selected by the RIP. For more
detail, see the Harmony reference documentation for your specific workflow.
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Target Curves
A target curve represents the tonal or dot gain characteristic of the printing
that you want to match.

Spectrum

You can use your own targets and create target curves for them.
Alternatively, you can import predefined target curves into the Harmony
database from the CreoTargets.hmy or ImationTargets.hmy (for Spectrum
proofs) files found in the Harmony folder. These curves are based on
industry standards or qualified by Creo and its partners.

Current Curves
A current curve represents the tonal value or dot gain characteristic of your
current printing.
The number of current curves that you produce varies by the degree to
which tonal reproduction is affected by printing variables. For example,
you may have a different current curve for each press, and/or each kind of
paper stock, and/or each type of plate used.
See How Many Calibration Curves Do You Need? on page 14.

Calibration Curves: Derived and Transfer
You can use two types of calibration curves in Harmony: derived and
transfer.
Derived Calibration Curves

A derived calibration curve is the most common type of curve. It is derived
from the target profile and current profile that you specify. Its curve
represents the adjustment needed to the tint specified in the digital file so
that your target is achieved on press. Though target and current curves are
saved separately in the Harmony database, the link between them is
maintained in the derived calibration curve saved in the Harmony
database.
Transfer Calibration Curves

A transfer curve is a calibration curve that is not linked to a target and
current curve. There are three ways to create transfer calibration curves:

•

create a new transfer calibration curve

Types of Curves
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For more information, see Creating Transfer Calibration Curves on
page 54.

•

convert a derived calibration curve to a transfer calibration curve
You usually convert a derived calibration curve so that you can adjust it
independently of the target or current curve.
For more information, see Making Derived Curves Transfer Curves on
page 98.

•

import a calibration curve from another calibration utility
Imported calibration curves are transfer calibration curves because
Harmony cannot determine how these curves were derived.
For more information, see Importing and Exporting Harmony Curves on
page 92 or the Harmony reference documentation for your specific
workflow.

Curve Sets
A target, current, or calibration curve may be composed of a One Curve
curve set, a four-curve CMYK Curves curve set, or a Spot Curves curve set.
For target and current curves, the curve set is defined in the curve’s
properties when creating a new curve, and once defined cannot be
changed. For a calibration curve, the only way to change the curve set is to
first convert the derived calibration curve to a transfer calibration curve.
For more information, see Changing Curve Sets of a Transfer Curve on
page 99.

One Curve Set
A One Curve curve set is measured from a single process color (C, M, Y,
or K) to create one calibration curve that is applied to all color separations.
With a One Curve curve set, you must specify the color you are measuring
by selecting it from the Measured Color box when you set new target curve
or current curve properties. See Creating Target Curves on page 45 and
Creating Current Curves on page 47.
The black separation is typically measured to create a calibration curve for
use with all colors. However, Harmony lets you choose another color as
your measured color. If dot gain is atypical in the black printing unit, you
may choose to measure another, preferably high-contrast, color, like
magenta.
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In almost all cases, a One Curve curve set will be sufficient for calibration.

CMYK Curves Set
A CMYK Curves curve set is measured from each separation—that is, each
of C, M, Y, and K. A color-specific curve is used for each color separation.
The black calibration curve is applied to all spot colors unless you build
calibration curves for spot colors. See Spot Curves Set.
Color-specific curves are useful only when:

•

correcting gray balance problems
For more information, see Importing and Exporting Harmony Curves on
page 92.

•

the relative dot gain between press and proof varies from color to
color—that is, one unit on your press prints heavier than the others

For more information about using color-specific curves, see When to Use
Color-Specific Curves on page 13.

Spot Curves Set
A Spot Curves curve set is measured from a specific single color to create
one calibration curve that is applied to that color separation only. With a
Spot Curves curve set, you must specify the color you are measuring by
typing the name in the Spot Color box when you set new target or current
curve properties. You can define as many spot color curves as you like. The
Spot Curves curve set is most appropriate for measuring duotone and
tritone images.

Types of Curves
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Matching the Curve Sets
When a derived calibration curve is created, the curve sets of the selected
target and current curves must match to ensure that the calibration
calculations are accurate.
The following table shows possible matching curve set combinations.
Current
Curve Set

Target
Curve Set

Measured
Color

Match
Allowed

Resulting
Calibration
Curve

One Curve

One Curve

Same

Yes

One Curve

One Curve

One Curve

Different

No

N/A

One Curve

CMYK Curves

1

Yes

One Curve

One Curve

Spot Curves

N/A

No

N/A

CMYK Curves

One Curve

2

Yes

One Curve

CMYK Curves

CMYK Curves

N/A

Yes

CMYK Curves

CMYK Curves

Spot Curves

N/A

No

N/A

Spot Curves

One Curve

N/A

Yes3

Spot Curves4

Spot Curves

CMYK Curves

5

Yes3

Spot Curves4

Spot Curves

Spot Curves

Same

Yes

Spot Curves

Different

Yes3

Spot Curves4

Spot Curves

Spot Curves

1

The current curve’s measured color is matched with the target curve’s C, M, Y, or K curve profile.

2

The target curve’s measured color is matched with the current curve’s C, M, Y, or K curve profile.

3

A warning appears before the calibration curve is created.

4

Same spot color as the current curve’s spot color.

5

You must choose a C, M, Y, or K curve profile from the target curve and match it with the current
curve.
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Curve Naming
Harmony automatically assigns a name to each current and calibration
curve. The name is based on the attribute information you type or select
for that curve. For target curves, you must assign a name to each curve you
create. The curve name displays in the curve window title bar when the
curve is saved.
For more information about naming curves, refer to the Harmony reference
documentation for your specific workflow.

Curve Window
There are four types of curve windows:

•
•
•
•

current
target
derived calibration
transfer calibration

You can have multiple curve windows open at the same time.

Click the tabs
to change the
curve graph
displayed.
Nodes
Node sidebar

Figure 8: Calibration Curve window

A derived calibration curve window also lets you view the current and
target curves linked to the calibration curve. Click the Current Curve,
Target Curve, or Calibration Curve tabs to display the corresponding curve

Curve Window
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graph. Click the All Curves tab if you want to display all three curves—that
is, the target, current, and calibration curves—together on the curve
graph. For more information about curves, see Types of Curves on page 25.
Most of the curve window features described below are available for all
types of curves. If a feature is specific to a particular type of curve, it is
noted.

Cursor Position
Cursor Position is a floating window that displays the position of the
cursor on the graph. It helps you more accurately place or move the nodes
on the graph.

x axis

y axis
Cursor Position bar

Figure 9: Cursor Position window

The numbered pair shown in the Cursor Position bar indicates the cursor
position on the x and y axes, respectively. For example, a value of 18, 23.5
means that the point on the graph is at 18 units on the x axis and 23.5 units
on the y axis.

Hiding and Displaying the Cursor Position Window
To hide or show the Cursor Position window:

½ From the View menu, select Cursor Position.

If the cursor position was in view, it is now hidden, and the check mark
next to Cursor Position no longer displays.
If the cursor position was hidden, it now displays, and a check mark
appears next to Cursor Position.
Each time you select Cursor Position, it is displayed or hidden.

32

Chapter 2 – Getting Started

Graph x and y Values
x Axis

For all curves, the x value is the digital file tint that was requested. The x
axis encompasses 0 through 100, in whole numbers only.
y Axis

For current and target curves, the y value is the tonal value that was
measured on the output sample, called measured dot area (MDA). For
proofs and press sheets, this means effective dot area (EDA); for film, this
mean physical dot area (PDA).
For calibration curves, the y value is the calibrated tint value—that is, the
value to which the tint specified in the digital file will be adjusted when the
calibration curve is applied.
The y axis encompasses 0.0 through 100.0, increased in values of 0.1. For
ease of mouse movement, you can set a decimal value as a snap-to
measurement. If set, the node will jump to the next nearest decimal value
you set when you move the node along the y axis using your mouse. See
Moving Nodes on page 37.
y axis
x axis

Figure 10: x and y axes of a graph

Node Sidebar
The node sidebar consists of two tabs: Curve and Nodes.
The Curve tab shows each node that you can add: 1 through 99. You can
add or delete nodes by selecting or clearing the make active (x) check box.
You can modify the y values by clicking in the EDA box and typing a new
value.
Note: EDA (Effective dot area) displays as measured dot area (MDA) if the output
type is plate, and displays as physical dot area (PDA) if the output type is film.

The Nodes tab shows all active nodes on the curve.

Curve Window
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To move between active nodes:

½ For both the Curve and Nodes tabs, press ENTER to move the cursor

from one active node to the next.

y value = dot area
measured by
densitometer
x value =
digital file
tint
make active check box

Figure 11: Node sidebar

Opening an Existing Curve
You can open any type of curve that exists in the Harmony database.
To open a curve using the menu bar:
1.

From the Harmony database window, highlight the curve you want to
open by clicking the curve row once.
Note: To select multiple curves within the same tab, hold down the CTRL
key, and then click each curve you want to select.

2.

From the File menu, select Open Curve.

To open a curve by double-clicking:

½ From the Harmony database window, double-click on the curve you

want to open.
To open a curve using the shortcut menu:

½ From the Harmony database window, right-click to display the
shortcut menu, and then select Open Curve.
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Copying an Existing Curve
Harmony allows you to make copies of existing curves of any type.
Copying curves can be useful for many reasons. For example, if you want
to experiment with curve deviation or converting to a transfer calibration
curve, you can make a copy of the derived curve to work on, while
retaining the original curve.
To copy a curve using the menu bar:
1.

From the Harmony database window, highlight the curve you want to
open by clicking the curve row once.

2.

From the File menu, select Copy Curve.
A copy of the curve is created, and Copy <n> is appended to the curve
name. For example, if you made a copy of a curve named
PlateLinear, the copy would be called PlateLinear Copy 2.
You can change the name of the copied curve in the curve’s properties.
See Modifying Curve Properties on page 89.

To copy a curve using the shortcut menu:

½ From the Harmony database window, right-click to display the
shortcut menu, and then select Copy Curve.

A copy of the curve is created and Copy <n> is appended to the curve
name. For example, if you made a copy of a curve named
PlateLinear, the copy would be called PlateLinear Copy 2.
You can change the name of the copied curve in the curve’s properties.
See Modifying Curve Properties on page 89.

Using the Curve Graphs
Target and current curves are created by entering nodes onto the curve
graph. A node is composed of numbered pair values (x and y). A node set
is composed of a series of nodes on the graph. The line that connects the
nodes forms the profile of the curve.
You can add a node set when opening a new target or current curve, or you
can enter the node set manually once the curve is open. You can also add
and delete individual nodes on the curve graph.

Using the Curve Graphs
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Adding or Deleting Nodes
Adding a Node Set
You can add a node set to a target or current curve when you set the new
curve’s properties. This is useful for measuring tints because you don’t
have to add a series of nodes manually.
You can create your own set of nodes or use one of the default node sets in
Harmony.
Note: You must add a default node set when you create a new curve. You
cannot add a default node set by modify the curve properties of an existing
curve.
Tip: If you are using a strip reader to measure tints, do not add a set of nodes to
your curve. The strip reader automatically adds the nodes for you.

To add a node set:
1.

In the New Current Curve Properties dialog box or New Target Curve
Properties dialog box, click the Data Entry tab.

Figure 12: New Current Curve Properties dialog box (data entry tab)
2.

From the Nodes list box, select a default node set.
Or:
To create your own node set, in the Nodes list box, type the node values
you want to add to your graph. You must leave a space or type a
comma between each value.
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Adding or Deleting Individual Nodes
Once you have created a curve graph, you can add or delete individual
nodes. This is useful if you want to smooth a curve.
For more detail, see Smoothing Target or Current Curves on page 73.
To add a node:

½ With the curve window open, hold down the CTRL key, then click the

mouse on the graph where you want to add the node.
A solid black plus sign is appended to the cursor when you can add a
node. A hollow plus sign indicates that the cursor isn’t close enough to
the curve.
Or:
½ Select the make active check box in the node sidebar. See Figure 11 on

page 33 for an illustration of the node sidebar.
To delete a node:

½ With the curve window open, press the SHIFT key and click the mouse

on the node you want to delete.
A solid black minus sign is appended to the cursor when you can delete
a node. A hollow minus sign indicates that the cursor isn’t close enough
to the node.
Note: If you continue to hold down the SHIFT key, you can drag the cursor
over multiple nodes to delete them. In this case, three solid black minus signs
are appended to the cursor.

Or:
½ Clear the make active check box in the node sidebar. See Figure 11 on

page 33 for an illustration of the node sidebar.

Converting Nodes to a Linear Curve
If you have been creating a current or target curve and decide that you
want to erase modifications made to the nodes, you can convert the curve
back to its original linear state. The curve will retain any default nodes that
were selected when you opened the curve.
Important: There is no undo for this action.

Using the Curve Graphs
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To convert all nodes to linear:
1.

Make sure that the correct curve is currently active.

2.

From the Edit menu, select Convert to Linear Curve.
All nodes are removed from the curve and it displays as linear with the
default nodes set for creating that current or target curve.

Moving Nodes
Once a node is on the graph, you can adjust the measured dot area by
moving it to a new location on the y axis. Each time a node is moved, the
entire curve is resampled based on the change made.
Note: Movement is constrained to the y axis only. If you want to change the x
axis value, you must delete the node, and then create a new one using the new
x axis value.

To move a node:
1.

Position the cursor on the node.
The indicator next to the cursor changes to a solid black double-arrow.
Note: If the indicator is a hollow double-arrow, the cursor is not close
enough to the node.

2.

Click and hold the mouse while you move the node up or down the
y axis, then release the mouse when you’ve reached the point on the
y axis where you want to move the node.
Note: If you are not getting accurate enough movement using the mouse,
you may want to adjust the snap-to guide or use the node sidebar.

Setting the Snap-To Guide
The snap-to guide helps ensure the accuracy of movement along the y axis
when you are using the mouse to move a node. The snap-to guide allows
you to move the node to the next nearest decimal value that you set. For
example, if the snap-to is set to 1.0 and you move the node from 50.0 to
50.5, the snap-to automatically jumps the node to 51.
To set the snap-to guide:

½ From the Edit menu, point to Snap Y To, and then select the

incremental value at which you want the node to move.
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Viewing Curves
This section describes the different ways that Harmony lets you view
curves on the desktop. You can select different views depending on your
needs.

View Dot Area or Dot Gain
You can view the curve graphs as dot area or dot gain. The default view is
dot area.

Dot area

Dot gain

Figure 13: Dot area and dot gain curve graphs

To switch between the views:
1.

From the View menu, point to Graph Type.

2.

Select one of the following:

•

Dot Gain to show the amount of dot gain.

Or:

•

Dot Area to show the effective dot area

A check mark displays next to the active view.

Using the Curve Graphs
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Polarity
There are two ways to view a curve: positive mode or negative mode.
Positive mode is the standard mode and the only mode available if you are
calibrating to press sheet. It means that you are measuring the 0% tint as
paper white (no ink) and the 100% tint as solid ink.
Negative mode is used only when:

•

You are using negative film or negative plates.
On negative film or plates, the 0% tint appears as the darkest tint, and
the 100% tint appears as the lightest tint. Polyester plates are commonly
used as negative plates.
AND

•

Your densitometer is not able to read the 0% tint as paper white
because it is the darkest area of the film or plate.

If you are using negative mode, read the 100% tint when your
densitometer asks for paper white and read the 0% tint when your
densitometer asks for solid.
To set the polarity when opening a new curve:
1.

In the Identification tab of the curve’s Calibration Curve Properties
dialog box, select either Film or Plate in the Type box.

2.

In the Data Entry tab, select a value from the Polarity box.

To set the polarity when the curve is already open:

½ From the Edit menu, point to Polarity, and then select either Positive
or Negative.

A check mark displays next to the active polarity type.
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Setting Up Your Densitometer
If you are using automatic densitometer input, you must set up the
densitometer in Harmony before you can use it. You also need to connect
the densitometer to a serial port on your computer.
For more information on connecting your densitometer, see Connecting
the Densitometer on page 127.
Note: Much of the information that should be entered depends on the type of
densitometer you are using. Consult your densitometer documentation to find
out the best settings for your densitometer.

To set up your densitometer in Harmony:
1.

From the Edit menu, select Preferences.
The Preferences dialog box displays.

Figure 14: Preferences dialog box
2.

Select the brand of densitometer you are using from the Brand box.

3.

Select the densitometer model you are using from the Protocol box.
Note: The densitometer models available are automatically set based on the
brand of densitometer you selected.

4.

Select the Enable audio feedback check box if you want Harmony to
provide sound cues when using the auto densitometer input feature.
Note: Your computer must have a sound card and speakers to use the audio
feedback feature.

Setting Up Your Densitometer
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5.

Select a serial port from the Com Port box.

6.

Select the appropriate settings for the remaining options.

7.

Click OK to close the Preferences dialog box and save your settings.
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New Harmony Curves
You can create four new curves in Harmony:

•
•
•
•

target curves
current curves
derived calibration curves
transfer calibration curves

A target curve represents the tonal reproduction you would like to have. A
current curve represents the tonal reproduction that you are currently
achieving. A derived calibration curve, which Harmony derives from the
target and current profiles you define, represents the amount Harmony
needs to compensate for the tint value specified in the digital file to achieve
the target on your final output.
A transfer calibration curve can also be created from target and current
curve profiles, or you can define the transfer calibration curve profile
yourself. Regardless of their origin, transfer calibration curves are not
linked to a target and current curve profile.
Target and current curves are not the end products of Harmony—that is,
they are never selected by the RIP to calibrate the file; only calibration
curves are selected when the file is RIPed.
Note: A calibration curve must be enabled in order to be selected by the RIP. For
more information, see the Harmony reference documentation for your specific
workflow.

In most cases, you will want to create derived calibration curves to apply to
your output. To create a derived calibration curve, you first need to create
a target curve and current curve. You then link the target and current
curves, and Harmony produces the calibration curve.
Figure 25 on page 53 illustrates the steps for creating a derived calibration
curve.

Creating Target Curves
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You build

Target
curve

You build

Current
curve

Harmony database

Derived
calibration
curve

All curves are stored
in the database.

Harmony creates

Figure 15: New curves in Harmony

Creating Target Curves
Spectrum

A target curve is a graph that maps out the effective dot area or dot gain
measured on the sample that represents your desired printing. You can
create your own curve, or you can use one of the default target curves
provided in the Harmony CreoTargets.hmy or ImationTargets.hmy files.
To create a target curve:
1.

Decide which output type you want to calibrate: paper (press sheet or
proof), plate, or film. You should calibrate the same output type as
your final deliverable.
See Selecting Your Output Type on page 60.

2.

Select your target sample.
See Selecting Your Target Sample on page 60.
Note: If you decide to use a predefined target curve from the
CreoTargets.hmy or ImationTargets.hmy files instead of creating a target
curve, you must first import the target curve into the Harmony database. See
Importing and Exporting Harmony Curves on page 92 or the Harmony
reference documentation for your specific workflow.

Before using any curve from the CreoTargets.hmy or
ImationTargets.hmy files as a target, you must save it using a different
name because the curves in these files are read-only. See Saving ReadOnly Target Curves on page 76.
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3.

From the File menu, point to New Curve, and then select Target.
The New Target Curve Properties dialog box displays.

Figure 16: New Target Curve Properties dialog box
4.

On each tab, select or type property information about the target
curve.
Note: You don’t need to fill in the Name box on the Identification tab, the
box on the Comments tab, and the Nodes box on the Data Entry tab
before you can open a new curve.

For details, see Target Curve Properties on page 78.
5.

Click OK.
The Target Curve window displays.

Figure 17: Target Curve window

Creating Current Curves
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6.

Measure the tints on the target sample, and record the measurements
in the new target curve.
See Measuring Tints on page 63.

7.

Smooth the curve.
See Smoothing Target or Current Curves on page 73.

8.

Save the curve.
See Saving Curves on page 75.

Creating Current Curves
A current curve is a graph that maps out the effective dot area or dot gain
measured on a sample of your current printing.
To create a current curve:
1.

Select the output type—paper (press sheet or proof), plate, or film—
that you are calibrating.
See Selecting Your Output Type on page 60.
Note: To create a calibration curve, the output type of the target and
current curves must be the same. You should select the same output type as
the target curve you plan to use. You must also ensure that the curve sets of
your target and current curves are an acceptable match. For more detail, see
Matching the Curve Sets on page 29.

2.

Obtain a sample of your current output—that is, what you are
currently producing.
See Obtaining Your Current Sample on page 61.

3.

From the File menu, point to New Curve, and then select Current.
The New Current Curve Properties dialog box displays.
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Figure 18: New Current Curve Properties dialog box
4.

On each tab, select or type property information about the current
curve.
Note: You don’t need to fill in the First Name box on the Identification
tab, the box on the Comments tab, and the Nodes box on the Data Entry
tab before you can open a new curve. For details, see Current Curve
Properties on page 80.
You can only select an option from the Screening System box on the
Screening tab if you have Delta workflow.

Delta
5.

Click OK.
The Current Curve window displays.

Figure 19: Current Curve window
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Measure the tints on the current sample, and record the
measurements in the new current curve.
See Measuring Tints on page 63.

7.

Smooth the curve.
See Smoothing Target or Current Curves on page 73.

8.

Save the curve.
See Saving Curves on page 75.

Creating Derived Calibration Curves
Harmony creates a derived calibration curve by looking at the target curve
and current curve, and then determining how much to adjust for the tint
specified in the digital file so that printing will match your target, under
the same operating conditions.
A derived calibration curve is created using existing target and current
curves. The curves must use the same output type—paper, plate, or film—
and if using a One Curve curve set, the measured color must be the same—
black, cyan, magenta, or yellow.
To create a derived calibration curve:
1.

From the File menu, point to New Curve, then point to Calibration,
and select Derived.
The New Calibration Curve dialog box displays.

Browse
button

Browse
button

Figure 20: New Calibration Curve dialog box
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2.

Under Current Curve, click the Browse button.
The Use Current Curve dialog box displays.

Figure 21: Use Current Curve dialog box
3.

Select the current curve in the list box you want to use, then click OK.
Or:
Double-click the current curve in the list box you want to use.
The Use Current Curve dialog box closes, and the New Calibration
Curve dialog box displays again.
The Name, Type, and Curve Set boxes are filled in automatically with
information from the current curve’s properties. The screening and
medium parameters are entered automatically in the derived
calibration curve’s properties.
Note: If the selected current curve’s curve set is One Curve, the measured
color displays; or, if the selected current curve’s curve set is Spot Curves, the
spot color displays.

4.

Under Target Curve, click the Browse button.
The Use Target Curve dialog box displays.

Creating Derived Calibration Curves
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Figure 22: Use Target Curve dialog box
5.

Select the target curve in the list box you want to use, and then click
OK.
Or:
Double-click the target curve in the list box you want to use.
The Use Target Curve dialog box closes, and the New Calibration
Curve dialog box displays again.
The Name, Type, and Curve Set boxes are filled in automatically with
information from the target curve’s properties.
Note: If the selected current curve’s curve set is One Curve, the measured
color displays; or, if the selected current curve’s curve set is Spot Curves, the
spot color displays.

6.

Click OK.
The Calibration Curve window displays.
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Figure 23: Calibration Curve window

If a warning message displays, the output type, curve set type, One
Curve curve set measured colors, or Spot Curves curve set spot colors
of the current and target curves do not match. To correct the problem,
see Matching the Curve Sets on page 29.

Figure 24: Harmony warning message
7.

If the warning message displayed in the previous step prevents you
from creating a calibration curve with your settings, reselect a target
or current curve.
In some cases, the warning message may let you create a calibration
curve even though Harmony does not consider your settings
compatible. If you don’t want to create the calibration curve with these
settings, reselect a target or current curve.

8.

Inspect the resulting calibration curve for severe jumps, particularly in
the deep shadows.
If there are severe jumps, correct them by adjusting or deleting nodes
in either the current or target curve. See Smoothing Target or Current
Curves on page 73.

9.

Save the curve. See Saving Curves on page 75.

Testing Derived Calibration Curves
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Testing Derived Calibration Curves
If you are calibrating the Paper output type, we recommend that you try a
calibrated press run after creating a derived calibration curve. If you do not
achieve the desired result on press, you need to adjust either the target or
current curve linked to the derived calibration curve. See Figure 25.
Create
target
curve

Create
current
curve
Derive
calibrated
curve

Try
calibrated
press run

Do the
tints match?

No

Check
printing
conditions

Edit
current
curve

Yes

Edit
target
curve

No

Is tone
reproduction
desirable?

Yes
Legend
Stop.
No further
calibration
necessary

User operation
User decision

Figure 25: Creating and testing a derived calibration curve
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Creating Transfer Calibration Curves
A transfer calibration curve is a graph that maps a calibrated tint onto the
tint specified in the digital file you input to the RIP. Unlike a derived
calibration curve, a transfer calibration curve is not linked to a current or
target curve.
You can create a transfer calibration curve from a derived origin—that is,
you select and match a target and current curve in the Harmony
database—or you can create your own profile for a transfer calibration
curve.
Note: If you create a transfer calibration curve from a derived origin, the current
and target curves you select must use the same output type, and if using a One
Curve curve set, the measured color must be the same—black, cyan, magenta or
yellow.

To create a transfer calibration curve:
1.

From the File menu, point to New Curve, then point to Calibration,
and select Transfer.
The New Transfer Curve dialog box displays.

Figure 26: New Transfer Curve dialog box
2.

If you want to create a linear transfer curve, click OK; otherwise, go to
the next step.
Harmony creates the curve, and the Transfer Calibration Curve
window displays.

Creating Transfer Calibration Curves

55

Figure 27: Transfer Calibration Curve window
3.

If you want to you want create a transfer calibration curve from a
derived origin, select the Derived Origin check box.

Browse
Button

Browse
Button

Figure 28: New Transfer Curve Dialog Box (Derived Origin)
4.

Under Current Curve, click the Browse button.
The Use Current Curve dialog box displays.
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Figure 29: Use Current Curve dialog box
5.

Select the current curve in the list box you want to use, and then click
OK.
Or:
Double-click the current curve in the list box you want to use.
The Use Current Curve dialog box closes, and the New Transfer Curve
dialog box displays again.
The Name, Type, and Curve Set boxes are filled in automatically with
information from the current curve’s properties. The screening and
medium parameters are entered automatically in the transfer
calibration curve’s properties.
Note: If the selected current curve’s curve set is One Curve, the measured
color displays; or, if the selected current curve’s curve set is Spot Curves, the
spot color displays.

6.

Under Target Curve, click the Browse button.
The Use Target Curve dialog box displays.

Creating Transfer Calibration Curves
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Figure 30: Use Target Curve dialog box
7.

Select the target curve in the list box you want to use, and then click
OK.
Or:
Double-click the target curve in the list box you want to use.
The Use Target Curve dialog box closes, and the New Transfer Curve
dialog box displays again.
The Name, Type, and Curve Set boxes are filled in automatically with
information from the target curve’s properties.
Note: If the selected current curve’s curve set is One Curve, the measured
color displays; or, if the selected current curve’s curve set is Spot Curves, the
spot color displays.

8.

Click OK.
If a warning message displays, the output type, curve set type, One
Curve curve set measured colors, or Spot Curves curve set spot colors
of the current and target curves do not match.

Figure 31: Harmony warning message

To correct the problem, see Matching the Curve Sets on page 29.
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9.

If the warning message displayed in the previous step prevents you
from creating the curve with your settings, reselect a target or current
curve.
In some cases, the warning message may allow you to create a
calibration curve even though Harmony does not consider your
settings compatible. If you don’t want to create the calibration curve
with these settings, reselect a target or current curve.

10. Inspect the resulting calibration curve for severe jumps, particularly in

the deep shadows.
If there are severe jumps, correct them by deviating the curve. See
Deviating Curves on page 100.
Note: A transfer curve is always in deviation mode.
11. Save the curve.

See Saving Curves on page 75.
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Selecting Your Output Type
Before you acquire target and current samples and begin creating curves,
you must determine what you are trying to calibrate and why. This will
help you decide which output type to calibrate—film, plate, or paper
(press sheet or proof).
For regular printing operations, we always recommend calibrating paper.
Plate calibration is useful if you can’t do press sheet calibration—that is, if
you can’t produce a press sheet or proof for your current sample. If you
make film, you can use Harmony to ensure that the film you produce is
linear (the dots on the film are the same size as the dots specified in the
digital file).
For more detail, see Choosing Which Output Type to Calibrate on page 14.
Once you know which output type you are calibrating, you can:

•
•

decide what your target will be, and, if necessary, get a sample
get a current sample

Selecting Your Target Sample
A target sample represents the print reproduction you want to achieve. You
can either use a predefined target curve supplied with Harmony or create
your own target curve.

Using Predefined Targets
Spectrum

Harmony provides default target curves that represent industry-standard,
acceptable dot gain. To use a predefined curve, you must import the curve
from the CreoTargets.hmy or ImationTargets.hmy file.
For information on importing curves, see Importing and Exporting Harmony
Curves on page 92 or refer to the Harmony reference documentation for your
specific workflow.
Note: The curves in the CreoTargets.hmy and ImationTargets.hmy files are
read-only. To use one of these curves, you must save it first using a different
name.

Obtaining Your Current Sample
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Using Your Own Targets
If you want to use your own target curves, make sure each target sample
you select has some kind of tint bar and gray balance pattern for
measuring. Harmony provides tint bar and gray balance pattern files.
For paper (press sheet or proof) calibration, a standard target would be a

proof, a previously produced press sheet, or an industry standard. In some
cases, it could be a sample from your client.
For plate calibration, a standard target would be a well-calibrated plate.
For film calibration, a standard target would be a linear curve.

You may choose to have more than one target. For example, you may
profile each type of proofer, as well as customer-supplied proofs.
Alternatively, proofers can also be calibrated to match a standard—the
same standard used for a press target.

Agreeing on a Target
Deciding on your target(s) is a very important step in the process because
the sample defines what is desired and what the calibration curve will
achieve on the final output.
Important: Make sure that everyone who has a say in print reproduction quality
(for example—press operators, prepress operators, operations managers, quality
assurance personnel) agrees with the chosen target. If they don’t approve of or
don’t know about the target, they may not agree with the printing that is
produced when the calibration curve is applied.

Obtaining Your Current Sample
To measure the amount of dot gain you are currently producing, you need
to get a sample of each output device you are trying to calibrate. The
sample should be as current as possible, and each sample must have some
kind of tint bar and gray balance pattern for measuring. Harmony provides
tint bar and gray balance pattern files.
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Techniques for Ensuring Accurate Samples
The accuracy of your target and current samples depends on a number of
factors. To ensure accurate samples, follow the recommendations for the
factors listed.
Tint Bar or Other Test Marks

•

When adding the tint bar or other test marks to your printing form,
avoid the extremities of the form and orient the marks so that they run
around the plate cylinder rather than across it.

Equipment

•

Make sure the film or plate processor is in optimal condition—that is,
it is clean, has good chemistry and appropriate temperatures, has
proper speed settings, etc.

•

Correct the laser exposure on the output device before imaging.

RIP

•

Ensure correct screening settings are chosen. For more information,
see your RIP documentation.

•

Determine which calibration curve, if any, is being applied to the
sample.

Output Media

•

Use exactly the same media (press sheet, proof, film, or plate) you
intend to use when the calibration curve is applied.
For example if your deliverable is a press sheet, use the same paper stock
that you will use when the calibration curve is applied.
Note: If you use different kinds of media, and each medium produces
significantly different dot gain (tone value increase), you may want to create
current samples for each.

Press (if your final deliverable is a press sheet)

•
•

Obtain a sample that reflects the average operating point of your press.
Run your press at its optimal point and use standard ink densities.

Measuring Tints
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Measuring Tints
Once the target sample is selected and you obtain a current sample, you
need to measure the tints on each sample using a densitometer. See
Measuring Device on page 16.
Note: If you are measuring negative film or plates and your densitometer cannot
read the 0% tint as paper white, you need to work in negative mode. See Polarity
on page 39.

What the Densitometer Measures
The densitometer measures dot area on the output, which is the total
amount of light absorbed by the tint. The curve created is composed of the
relationship between the tint specified in the digital file and the dot area
that you measured.
Each of these numbered pairs becomes one node on the curve graph, as
illustrated in Figure 32.
Densitometer
reads 49%

Curve graph
Dot area

45%
50%
55%

49

45, 49
Numbered pair
entered as a node
on the graph

Tint bar

45

Digital file tint

Figure 32: Relationship between readings and curves

If you are having trouble taking measurements, see Taking Accurate
Densitometer Readings, or Chapter 7, Troubleshooting.
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Taking Accurate Densitometer Readings
Use the following techniques to ensure your densitometer readings are
accurate:

•
•

Set your Yule-Nielson factor to 1. Do not adjust it while measuring.
Use a quality test file.
For example, use a UGRA scale, digital test image, RIT scale, etc.
Quality tint bars are also provided with Harmony.

•

Take all measurements from the same area of the output.
For example, do not measure black from one part of the press sheet,
and then take the rest of the measurements from another area of the
press sheet.
Take multiple measurements of the same tint and determine the
average of all the measurements.

•

For plates, take all measurements in the same plate grain direction.

Automatic Densitometer Input
If you have a densitometer or spectrophotometer with a serial cable, you
can use the automatic densitometer input feature to record the readings
when you measure tints.
Note: If your densitometer is not one of the preconfigured densitometers in the
Brand and Protocol list boxes in the Preferences dialog box, see
Configuring Densitometers for Harmony on page 129.

Taking Accurate Densitometer Readings

65

To use automatic densitometer input for a sample:
1.

Make sure that you have a target or current curve open.

Figure 33: Current Curve window (no readings input)
2.

If you didn’t select default nodes when opening the curve, add nodes
now.
See Adding a Node Set on page 35.

3.

If you didn’t configure your densitometer, set it up now.
See Setting Up Your Densitometer on page 40.

4.

From the View menu, select Densitometer Input.
The Densitometer Input dialog box displays.

Status
Window

Click the arrows
to select the
number of samples
you want to use.

Figure 34: Densitometer Input dialog box
5.

With your densitometer, measure a 0% tint or paper white on your
tint bar.
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If your densitometer supports paper white, the Measure Paper
message displays and you can then measure paper white. Otherwise,
go to the next step.
6.

Harmony beeps once the paper measurement is detected.
To set up Harmony to beep, select the Enable audio feedback check
box on the Preferences dialog box when you set up your densitometer.

7.

With your densitometer, measure a 100% tint or solid density on your
tint bar.
If your densitometer supports solid density, the Measure Solid
message displays and you can then measure solid density. Otherwise,
go to the next step.
Important: If you are using negative film or plates AND your densitometer
will not read the 0% tint as white, you must read the 100% tint as white
and the 0% tint as solid. See Polarity on page 39.

8.

Select the number of samples you want to use for each tint by clicking
the arrow buttons located next to the Samples button.
Note: You can measure up to five samples for each tint.

9.

Start measuring the tints.
The tint to measure displays in the status window.
As you measure a tint, Harmony beeps and the highlight moves to the
next sample, indicating where the next measurement will fall.
Harmony also creates the profile of the curve in the curve window as
you measure the tints.
Note: Right-click your mouse to move the highlight down the list of tints
instead of moving right to the next sample for the tint.

Harmony beeps twice when all of the samples for the tint have been
measured and transfers the average measurement to the curve.
Harmony beeps three times when all of the samples have been
measured.
10. Close the Densitometer Input dialog box.

The Target Curve window or Current Curve window displays.
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Figure 35: Current Curve window (readings input)
11. Smooth the curve, if necessary.

See Smoothing Target or Current Curves on page 73.
12. Save the curve.

See Saving Curves on page 75.

Strip Reader Input
If are using a strip reader to measure tints, you can use the automatic input
feature to record the readings when you measure tints.
Before measuring tints, you must also specify the appropriate settings in
the strips.cfg file in the Harmony folder. For more information, see
Appendix C, Setting Up Your Densitometer.
To use automatic input for a strip reader:
1.

Make sure that you have a target or current curve open.
Note: You don’t have to define nodes because the nodes or samples are
already defined by the strip.

2.

If you didn’t configure your strip reader, set it up now.
See Setting Up Your Densitometer on page 40.

3.

From the View menu, select Densitometer Input.
The Strip Reader Input dialog box displays.
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Figure 36: Strip Reader Input dialog box
4.

Click Change.
The Strip Selection dialog box displays.

Figure 37: Strip Selection dialog box
5.

Under Strip Name, select the strip you want to measure, and click OK.
Or:
Under Strip Name, double-click the name of the strip you want to
measure.
Note: You specify the strip names in the strips.cfg file in the Harmony
folder. For more information, see Appendix C, Setting Up Your
Densitometer.

The Strip Selection dialog box closes and the Strip Reader Input dialog
box displays again.
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Figure 38: Strip Reader Input dialog box (strip selected)

The name of the strip and the number of test patches for that strip
display in the Name and Number of Patches boxes. The tint values for
the patches display in the Tint column.
6.

Insert the strip into the strip reader.

7.

Click the Measure button.
The strip is measured and the result displays in the Reading column.
Note: If you’re using an X-Rite DTP32 strip reader, click Get Readings after
the strip has been read to display readings for the tint.

70

Chapter 4 – Acquiring Target and Current Samples

Click
Get Readings
to display
readings in the
Reading column

Reading column

Figure 39: Strip Reader Input dialog box
8.

Review the readings.

9.

If the readings are appropriate, click the Accept button to transfer the
measurements to the curve.
Or:
To remeasure, click the Clear button and measure the strip again.

10. Close the Strip Reader Input dialog box.

The Target Curve window or Current Curve window displays.

Figure 40: Current Curve window (readings input)
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11. Smooth the curve, if necessary.

See Smoothing Target or Current Curves on page 73.
12. Save the curve.

See Saving Curves on page 75.

Manual Densitometer Input
If you are using manual input, you need to measure the tints and then
input the tint values to Harmony.
To use manual densitometer input:
1.

Make sure that you have a target or current curve open.

Figure 41: Current Curve window
2.

If you didn’t select default nodes when opening the curve, add nodes
now.
See Adding a Node Set on page 35.

3.

With your densitometer, measure a 0% tint on the tint bar of your
sample.
Some densitometers call this paper white.
Important: If you are using negative film or negative plates AND your
densitometer will not read the 0% tint as white (since it will be the darkest
area of the film), you must read the 100% tint as paper white, and then
read the 0% tint as solid. See Polarity on page 39.
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4.

Measure a 100% tint on your tint bar.
Some densitometers call this solid.

5.

Enter the solid value in the Solid Density box in the curve window.

6.

Take measurements for all of the nodes listed on the curve.

7.

For each measurement you take, write down the digital file tint value
and the densitometer reading for the value—for example, 50,69.
Note: Taking multiple measurements of the same tint and using the average
of all measurements may increase the accuracy of the measurement.

8.

Type each value in the corresponding box in the node sidebar.

Type the tint value
you measured in the
corresponding box.

Figure 42: Node sidebar
Note: In both the Curve and Node tabs, using the ENTER key advances the
cursor to the next active node.

Harmony creates the profile of the curve as you input the
measurements.
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Figure 43: Current Curve window (readings input)
9.

Smooth the curve, if necessary.
See Figure 44 on page 74.

10. Save the curve.

See Saving Curves on page 75.

Smoothing Target or Current Curves
When taking multiple measurements with a densitometer, there is always a
slight margin for error. Possible reasons for error include human error or
variation in the tint patch. Errors are indicated by slight raises or dips in a
curve. Since a curve must be smooth for the output tints to change
gradually and evenly, you must smooth the curve by adjusting or removing
the nodes.
Note: Dot area curves are particularly sensitive in the shadow areas. In some
cases, raises in the curve in the shadows may be due to plugging or drops in
contrasts rather than a roundoff error caused by the densitometer.

To help you identify large discrepancies more quickly, the color of the
graph line changes to red if the curve cannot be drawn smoothly through
the nodes by Harmony.
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Before smoothing

After smoothing

Figure 44: Smoothing a curve

To smooth a curve:

½ Adjust the node so that the curve is smooth by measuring and

replotting the tints in the area where the jag occurs.
Or:
½ Delete the nodes that are causing problems. See Adding or Deleting

Nodes on page 35.
Nodes can be deleted from problem areas as long as the shape of the
resultant curve stays relative stable.
You may also want to try deviating the curve. See Deviating Curves on
page 100.

Saving Curves
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Saving Curves
Once the dot area values are entered on the graph and the graph is
smoothed, you should save the curve.
To save a curve:
1.

From the File menu, select Save Curve.
Or:
Right-click to display the shortcut menu, then select Save Curve.
Note: If you are saving a target curve, the Save Target Curve dialog box
displays if you haven’t already named your curve or the curve name is being
used by another curve.

Figure 45: Save Target Curve dialog box
2.

If you did not assign a name to the target curve when setting up the
target curve properties, type the name in the Curve box.
For target curves, assigning a name is required. For current or
calibration curves, you do not need to provide a name. Harmony
creates the curve’s last name using the screening and medium property
attributes.
For more information, see the Harmony reference documentation for
your specific workflow.

3.

If you want to alter the properties, click the Properties button, and
modify the properties for the curve. For more detail, see Modifying
Curve Properties on page 89.

4.

Click OK.
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Saving Read-Only Target Curves
When you import a predefined target curve into the Harmony database
from the CreoTargets.hmy or ImationTargets.hmy file that is supplied with
Harmony, you must save the curve using a different name because the
predefined curves are read-only
To save a curve using a different name:
1.

Open the curve you want to save.

2.

From the File menu, select Save Curve As.
Or:
Right-click the curve window to display the shortcut menu, and then
select Save Curve As.
The Save Target Curve As dialog box displays.

Figure 46: Save Target Curve As dialog box
3.

In the Curve box, type a new name for the target curve.

4.

Click Save.
You can now use the target curve.
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What Are Curve Properties?
Properties are attributes of the curve that give context to the curve data.
The properties let you manage the curves by entering information that
explains the environment in which the data was taken. As well, the
medium and screening properties of the calibration curve are used by the
RIP to determine which calibration curve to select.
Target and current curve properties must be set before a new curve can be
opened, because the properties determine which output type to calibrate
and which type of curve set to use. Derived calibration curves inherit the
properties of the current curve, but the attributes can be modified.
See Modifying Curve Properties on page 89.

Target Curve Properties
Before you can open a new target curve, you must set the properties for the
curve because the properties determine:

•
•

which output type to calibrate
which measured colors display on the curve graph

Figure 47: New Target Curve Properties dialog box

All of the attributes in the New Target Curve Properties dialog box except
Name box on the Identification tab, the box on the Comments tab, and the
Nodes box on the Data Entry tab, require entries before a new curve can be
opened. Some of the required attributes can be changed when saving the
curve.
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Assigning a Name to a Target Curve
You must create a name for each target curve to uniquely identify it. Target
curves do not have automatic naming applied to them.
See Curve Naming on page 30 or the Harmony reference documentation for
your specific workflow.

To assign a name to a target curve:
1.

Open the New Target Curve Properties dialog box.
See Creating Target Curves on page 45.

2.

On the Identification tab, type a name in the Name box.
We recommend choosing a unique name that will help you identify the
curve.

Setting Target Curve Attributes
Once you have assigned a name to the target curve, you need to set the
curve’s attributes.
To set the curve attributes for a target curve:
1.

On the Identification tab, select an output type from the Type box.
See Choosing Which Output Type to Calibrate on page 14.
If you selected either Plate or Film in the Type box, in the Data Entry
tab, select a mode in the Polarity box. See Polarity on page 39.
Otherwise, skip this step.

2.

In the Curve Set box, select:

•

One Curve if you want to use one curve for all separations. This is

the recommended option. If you select this option, you must also
select the appropriate color name from the Measured Color box.
The most common colors to measure are black and magenta
because they are high-contrast, easier to measure accurately, and
easier to distinguish during visual comparisons.

•

CMYK Curves if you want to use one curve for each CMYK

separation. This option is used for color proofing, but rarely for
final printed images. It is not recommended for new users.
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•

Spot Curves if you want to use one curve per spot color. If you

select this option, you must also type the appropriate color name
in the Spot Color box.
For more detail on curve set options, see Curve Sets on page 27.
3.

On the Data Entry tab, select the default node set that you want to
display from the Nodes box.
Or:
To define your own node set, type node values in the Nodes box.
Important: If you are using a strip reader as your measuring device, do not
select a node set. Your strip reader will automatically add nodes to the
graph when you measure your sample tints.

Current Curve Properties
Before you can open a new current curve, you must set the properties for
the curve. The properties determine:

•
•
•
•

which output type to calibrate
which measured colors display on the curve graph
the automatic naming of the curve, also called last name
the screening parameters and medium used to create the sample

Figure 48: New Current Curve Properties dialog box
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Note: All of the attributes except the First Name box on the Identification tab,
the box on the Comments, tab, and the Nodes box on the Data Entry tab
require entries before a new curve can be opened. Once a curve is open, the
Data Entry tab does not display.
Delta

You can only select an option from the Screening System box on the
Screening tab if you have Delta workflow.

Assigning a Name to a Current Curve
You don’t need to assign a name to a current curve because current curves
have a last name automatically applied to them, composed of their
screening and medium attributes. However, you may want to assign a
unique first name to the current curve to help you identify it.
For more detail about automatic curve naming, see the Harmony reference
documentation for your specific workflow.
To assign a name to a current curve:
1.

Open the New Current Curve Properties dialog box.
See Creating Current Curves on page 47.

2.

On the Identification tab, type a unique name that will help you
identify the curve in the First Name box.

Setting Current Curve Attributes
Once you have assigned a name to the current curve, you need to set the
curve’s attributes.
To set the curve attributes for a current curve:
1.

On the Identification tab, select an output type from the Type box.
See Choosing Which Output Type to Calibrate on page 14.

2.

If you selected Plate or Film in the Type box, on the Data Entry tab,
select a mode in the Polarity box.
Otherwise, skip this step.
See Polarity on page 39.
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3.

In the Curve Set box, select:

•

One Curve if you want to use one curve for all separations. This is
the recommended option. If you select this option, you must also
select the appropriate color name from the Measured Color box.
The most common colors to measure are black and magenta
because they are high-contrast, easier to measure accurately, and
easier to distinguish during visual comparisons.

•

CMYK Curves if you want to use one curve for each CMYK

separation. This option is used for color proofing, but rarely for
final printed images. It is not recommended for new users.

•

Spot Curves if you want to use one curve per spot color. If you

select this option, you must also type the appropriate color name
from the Spot Color box.
For more detail on curve set options, see Curve Sets on page 27.
4.

On the Data Entry tab, select the nodes that you want to display from
the Default Nodes box.
Or:
To define your own node set, type the node values in the Nodes box.
Important: If you are using a strip reader as your measuring device, do not
select a node set. Your strip reader will automatically add nodes to the
graph when you measure your sample tints.

Setting a Current Curve’s Medium and Screening
For a current curve, you need to specify the medium and screening
properties you are using for your current sample.
To set medium and screening for a current curve:
1.

On the Medium tab, select a medium from the Medium box.
Or:
Type a medium for your sample in the Medium box.

Current Curve Properties
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Figure 49: New Current Curve Properties dialog box (Medium tab)

If you have an iMPAct workflow with Platesetter Console or
Trendsetter Console, you can select a medium or type a medium index
or custom medium index number in the Medium box. You can only
type numeric values; alpha and special characters are not allowed

iMPAct

If you have a Prinergy workflow, in the Medium box, you can only type
a medium name or select a medium that you previously defined when
creating curves.

Prinergy

If you have a Delta workflow you can only select a medium from the
Medium list box; you cannot type the medium name.

Delta

For more detail, see the Harmony reference documentation for your
specific workflow.
2.

On the Screening tab, type or select the resolution for the current
sample in the Resolution box.

3.

In the Dot Shape box, type or select the dot shape for the current
sample.

4.

In the Ruling box, type or select the ruling for the current sample.
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Figure 50: New Current Curve Properties dialog box (Screening tab)

The Screening System property is only available if you have a Delta
workflow. For more detail, see the Harmony reference documentation
for a Delta workflow.

Delta

Using Calibrated Data
If a calibration curve was applied to the current sample you are measuring,
you need to enter that information in Harmony, because it will affect the
shape of any calibration curve that uses this current curve.
To measure a sample that was calibrated:
1.

In the Calibration tab, select the Calibrated Current Curve option.

Figure 51: New Current Curve Properties dialog box (Calibration tab)
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2.

In the ID box, type the ID number of the calibration curve as it
appears on the tint bar.
Note: To get the accurate revision of the calibration curve, you must enter
the ID that is on the sample, not select an ID from the current Harmony
database.

If Harmony cannot find the curve based on the ID number you enter,
you cannot use the calibrated sample, because Harmony will not be
able to trace the origins of the curve. This will result in an inaccurate
curve.
For more information about curve ID numbering, see the Harmony
reference documentation for your specific workflow.

Calibration Curve Properties
A calibration curve’s screening and medium properties define when to use
the curve. A derived calibration curve or transfer calibration curve of
derived origin initially inherits the screening and medium properties of the
current curve. However, you can modify the properties after you create the
curve.
Note: A linear transfer calibration curve does not inherit properties because it is
not derived from a current and target curve. You can assign and modify
calibration curve properties after you create the curve.

To modify calibration curve properties:
1.

Make sure the calibration curve is open.
See Opening an Existing Curve on page 33.

2.

From the Edit menu, select Curve Properties.
Or:
Right-click to display the short cut menu, and then select Curve
Properties.

The Calibration Curve Properties dialog box displays.
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Figure 52: Calibration Curve Properties dialog box

You can now modify the calibration curve’s properties.
See Modifying Curve Properties on page 89.

Assigning a Name to a Calibration Curve
You don’t need to assign a name to a derived calibration curve or transfer
calibration curve of derived origin since calibration curves have a last name
automatically applied to them, composed of their screening and medium
attributes. However, you may want to assign a unique first name to the
calibration curve to help you identify it.
For more detail about automatic curve naming, see the Harmony reference
documentation for your specific workflow.
To assign a name to a calibration curve:
1.

Open the Calibration Curve Properties dialog box.
See Calibration Curve Properties on page 85.

2.

On the Identification tab, type a unique name for the curve in the First
Name box.
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Modifying a Calibration Curve’s Medium and Screening
Initially, a derived calibration curve or transfer calibration curve of derived
origin inherits the screening and medium properties from the current
curve used to build the calibration curve. However, you can add additional
attributes to any medium or screening property, except resolution, at any
time.
You can also turn off a medium or screening property if you don’t want the
attributes of that property to limit the curve’s use. For example, if you want
the curve to be applicable for any medium, you can turn off the medium
property by clearing the Medium check box on the Medium tab. See
Figure 52 on page 86.

Adding Medium or Screening Attributes
To add medium or screening attributes:
1.

On the Medium or Screening tab, make sure the property’s limit use
check box—that is, the check box beside the property—is selected. If
you want to limit use of the curve to:

•
•
•

resolution, select the Resolution check box
dot shape, select the Dot Shape check box
line ruling, select the Ruling check box

See Figure 53 on page 88 for an illustration.
2.

Modify any of the following properties.
Note: For all properties, the attribute inherited from the current curve
cannot be cleared; it must always be selected.

Delta

Medium

To select the medium names that the curve can be used
for, select the check box next to each medium name
you want.

Screening
System

Available only if you have a Delta workflow. For more
detail, see your Harmony reference documentation for
a Delta workflow.

Resolution

This property is inherited from the current curve and
cannot be changed.
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Dot Shape

If you want to specify all dot shapes that the curve can
be used for, select the User Defined option, and then
select the check box next to each dot shape you want.
If you want the curve to be used for any AM (halftone)
dot, select the All AM option.
If you want the curve to be used for any FM
(stochastic) dot, select the All FM option.

Ruling

Set a line ruling range for the curve’s use.
The start of the range cannot be higher than the line
ruling specified in the current curve’s properties.

Note: If you don’t see a medium that you want, click the Add button, then type
the new medium in the box on the New Medium dialog box.
Prinergy

For more detail, see your Harmony reference documentation for a
Prinergy workflow.

Turning Off a Property
To turn off a property:

½ On the Medium or Screening tab, clear the limit use check box beside

the property you want to turn off.

Selecting the limit use
check box means the curve
can only be used for the
attributes displayed.
For example, this curve
can only be used at
2400 dpi, and for the
dot shapes selected.
If the limit use check box is
cleared, the curve’s use is
not limited by the attribute.
For example, this curve can
be used for any ruling.

Figure 53: Turning calibration curve properties on and off

By clearing the check box, you are no longer limiting use of the curve
for that property. For example, the calibration curve whose properties
are shown in Figure 53 can be used for images with any ruling (lpi).
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Modifying Curve Properties
After you have created a curve, you can modify the curve’s properties if you
want to change your settings. You can only modify the curve’s properties
when the curve is open. For all curves, the output type and curve set
cannot be modified.
To modify curve properties:
1.

If a derived calibration curve is open, select the tab of the curve whose
properties you want to display. Otherwise, go to the next step.

2.

From the Edit menu, select Curve Properties.
Or:
Right-click to display the shortcut menu, and then select Curve
Properties.

The Curve Properties dialog box for the type of curve you are
modifying—that is, calibration, current, or target—displays.

Figure 54: Current Curve Properties dialog box
3.

On the property tabs, modify the properties as required.

4.

Click OK.

5.

Save the curve.
The new settings are saved.
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Importing and Exporting Harmony Curves
The Import Curves and Export Curves options let you move individual or
groups of curve files between computers.
For example, you need to distribute a target curve to other printing sites so
that all sites are printing to the same target. This is important if you are a
multi-site printing company that prints the same job at more than one
location. The site distributing the target curve uses the Export Curves
option, and the receiving site uses the Import Curves option.

Spectrum

You also use the Import Curves option if you want to import existing
curves into the Harmony database. For example, if you want to use a
predefined target curve in the CreoTargets.hmy file, or the
ImationTargets.hmy file as a target, you must import the curve into the
Harmony database before you can use it.

Exporting Curves
Use the Export Curves option if you want to move curves from the local
Harmony database to another location.
To export Harmony curves:
1.

From the File menu, select Export Curves.
The Export Curves dialog box displays.

Browse button

Figure 55: Export Curves dialog box
2.

From the Export File Type box, select Harmony Database File.
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3.
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Beside the Export To File box, click the Browse button to find the
location of the Harmony database file that you are exporting to.
The Select Export File dialog box displays.

Figure 56: Select Export File dialog box
4.

Find the correct drive and folder containing the Harmony database
file that you are exporting the curve(s) to, and then select the database
file from the list of files displayed.
The name of the Harmony database file displays in the File name box.
Note: If you want to export a curve to a location that doesn’t contain a
Harmony database file, for example, to a floppy disk, you must type a name
in the File name box. Harmony will create a database file with the extension
.hmy in the location specified.

5.

Click the Open button.
The Select Export File dialog box closes, and the Export Curves dialog
box displays again.
The Harmony database file that you selected displays in the Export To
File box.

6.

On the Current Curve, Target Curve, and Calibration Curve tabs, select
the curves that you want to export.
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7.

8.

Under Export Options, select one of the following:
Always overwrite

The curves exported will automatically
overwrite any curves of the same name that are
found in the Harmony database file you are
exporting to.

Ask to overwrite

You will be cautioned each time a curve of the
same name exists in the Harmony database file
you are exporting to. You have the option to
overwrite or not overwrite.

Click the Export button.
The curve is exported to the location you specified.

Importing Curves
Use the Import Curves option if you want to move existing curves from
another location into the local Harmony database.
To import curves:
1.

From the File menu, select Import Curves.
The Import Curves dialog box displays.
Browse button

Figure 57: Import Curves dialog box
Note: When importing Allegro RIP 4.1 curves, the curves are converted to
transfer calibration curves.
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Beside the Import From File box, click the Browse button to find the
location of the database file that you are importing from.
The Select Import File dialog box displays.

Figure 58: Select Import File dialog box
3.

Find the correct drive and folder containing the database file that you
are importing the curve(s) from, and then select the file from the list
of files displayed.
The name of the database file displays in the File name box.

4.

Click the Open button.
The Select Import File dialog box closes, and the Import Curves dialog
box displays again.
The database file that you selected displays in the Import From File box.

Click the tabs
to change
the curve type
that you can
import.

Figure 59: Import Curves dialog box (file selected)
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5.

On the Current Curve, Target Curve, and Calibration Curve tabs, select
the curves that you want to import.

6.

Under Import Options, select one of the following:

7.

Always overwrite

The curves you import will automatically
overwrite any curves of the same name that are
found in the Harmony database you are
importing to.

Ask to overwrite

You will be cautioned each time a curve in the
database file you are importing from has the same
name as a curve in the database you are importing
to. You have the option to overwrite or not
overwrite.

Click the Import button.
Note: Calibration curves added to a Harmony database using the Import
Curves and Export Curves options are automatically disabled for selection
by the RIP. For the RIP to use the curves, you must manually enable each
curve.

The curve(s) you selected are imported to the Harmony database. For
more detail, see the Harmony reference documenation for your
specific workflow.

Adjusting for Gray Balance
Having gray balance means that the gray composed of a combination of C,
M, and Y (typically 50C, 39M, and 39Y) will produce a neutral gray—that
is, a gray that is not cold or warm, just neutral. Achieving gray balance also
means that a tint composed of the combination of C, M, and Y will match
the same tint composed of K only.
Before checking for gray balance, make sure that:

•
•
•

The ink densities of your press are correct.
You have acceptable registration.
The calibration curve used to print the gray balance pattern is smooth.

Adjusting for Gray Balance
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•

The color shift isn’t caused by the dot shape used. For example, a
Euclidean dot jumps at 50% because the dots join on all sides at that
tint. This jump may affect the 50% CMY grays.

If your grays have a consistent color cast across the full tonal range, they
can be correct on press. However, if a color cast occurs only in, for
example, the quarter tones, then color-specific calibration curves must be
used to correct the gray imbalance.
Important: Unlike calibration using target and current curves, fixing a gray
balance problem is not deterministic. It takes careful judgement and may take
several iterations to correct the problem.

To adjust the curves for gray balance:
1.

2.

Check for gray balance, ensuring that:

•

The three-color gray (C, M, and Y) produces a neutral hue in each
tint range.

•

The three-color tint matches the K only tint. In other words, it isn’t
heavier or lighter.

Convert the derived calibration curve used to print the gray balance
pattern to a transfer calibration curve.
See Making Derived Curves Transfer Curves on page 98.

3.

Convert the One Curve curve set to a CMYK Curves curve set.
See Changing Curve Sets of a Transfer Curve on page 99.

4.

Deviate the curve(s) as required to achieve balance.
See Deviating Curves on page 100.
For example, if your hue looks like it has too much cyan, deviate the
cyan curve down slightly. Or, if the three-color 50% tint looks like the
45% tint composed of black only, either deviate the black curve down
5% or deviate the cyan, magenta, and yellow curves up 5%.
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Making Derived Curves Transfer Curves
Converting a derived calibration curve to a transfer calibration curve
removes the link between the calibration curve and the target and current
curves it was derived from. You can edit a transfer curve in deviation
mode.
Usually, you convert a derived curve to a transfer curve when you want to
edit the calibration curve without affecting the data and accuracy of the
target and current curves, because these curves may also be linked to other
derived calibration curves.
Common reasons for converting curves are to adjust for gray balance or to
experiment with altering the calibration curve without changing the data
of the target or current curve.
To convert a derived curve to a transfer curve:
1.

If you want to retain the derived curve, make a copy of the curve.
See Copying an Existing Curve on page 34.

2.

Open the derived calibration curve you want to convert.
See Copying an Existing Curve on page 34.
Note: If you copied the curve in the previous step, open the copy.

3.

From the Edit menu, select Convert to Transfer.
A warning message displays, explaining that the link to the target and
current curves will be lost and asking if you want to continue.

Figure 60: Harmony warning message
4.

Click Yes.
The curve is converted to a transfer calibration curve.

Changing Curve Sets of a Transfer Curve
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Changing Curve Sets of a Transfer Curve
You can change the curve set from One Curve to CMYK Curves for transfer
calibration curves. The most common reason for changing the curve set is
when you are adjusting for gray balance and need color-specific curves.
For more information about curves sets, see Curve Sets on page 27.
To change the curve set:
1.

Open the transfer calibration curve.
See Opening an Existing Curve on page 33.

2.

From the Edit menu, select Curve Properties.
Or:
Right-click to display the shortcut menu, and then select Curve
Properties.

The Calibration Curve Properties dialog box displays.

Figure 61: Calibration Curve Properties dialog box
3.

On the Identification tab, in the Curve Set box, select CMYK Curves.
Copies of the original transfer calibration curve are created for each of
the other three colors so that you end up with identical cyan, magenta,
yellow, and black curves.
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Deviating Curves
Deviation mode lets you adjust the shape of an entire curve or a portion of
the curve. Deviation can be applied to target, current, or transfer
calibration curves.
Deviation is not automatically applied as you move the curve around so
that you can experiment without permanently changing the curve.
However, once you apply deviation to the curve, it cannot be undone.
Note: You can still revert to the last saved version of the curve by closing the
curve window without saving. When you reopen the curve window, the curve is
in the previous saved state.

Switching to Deviation Mode
To change the curve to deviation mode:
1.

Open the curve.
See Opening an Existing Curve on page 33.

2.

For transfer calibration curves, the curve is always in deviation mode;
skip to the next step.
For target or current curves, from the Edit menu, select Deviation
Mode.
Or:
Right-click to display the shortcut menu, then select Deviation Mode.
Deviation end points display at the ends of the curve.

Deviation
end point

Deviation
deviation
end point

Figure 62: Transfer Calibration Curve window (deviation mode)
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Deviating an Entire Curve
To deviate an entire curve:
1.

Make sure the curve window is open.

2.

Add a node.
See Adding or Deleting Nodes on page 35.
The node displays as a new deviation point.

Figure 63: Transfer Calibration Curve window (deviation point)
3.

Move the new node (deviation point) to adjust the curve.
The node displays as a regular node, and the curve is adjusted.

Figure 64: Transfer Calibration Curve window (deviated)
4.

Repeat steps 1 and 2 as needed, until you achieve the desired curve
shape.
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5.

To cancel the deviation(s), from the Edit menu, select Cancel
Deviation.
Or:
To save the deviation(s), from the Edit menu, select Apply Deviation.

Deviating an entire curve

Deviating part of a curve

Figure 65: Deviating a curve

Deviating Part of a Curve
The default end points for deviating a curve are at the ends of the curve.
This lets you modify the entire curve. To modify only a part of the curve,
you create new end points, and then add a node between them as the
control point. When you move the control point node, only the part of the
curve between the end points is adjusted.
To deviate part of a curve:
1.

Make sure the curve window is open.

2.

Add a node as a new end point at the end of the portion of the curve
you want to deviate.
See Adding or Deleting Nodes on page 35.
The node displays as a new deviation end point.
See Figure 66 on page 103.

3.

Add another node as the other end point of the portion of the curve
you want to deviate.
Or:
Use one of the two default end points at either end of the curve.

Deviating Curves
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See Figure 66 on page 103.
4.

Add a node between the two end points. This node is your control
point.
The node displays as a new deviation point. See Figure 66 on page 103.

5.

Move the control point to adjust the portion of the curve between the
end points.
The node displays as a regular node, and the curve is adjusted.

Control
point

New
end points

Figure 66: Transfer Calibration Curve window (partial deviation)
6.

Repeat steps 1 through 5 as needed, until you achieve the desired
curve shape.

7.

To cancel the deviation(s), from the Edit menu, select Cancel
Deviation.
Or:
To save the deviation(s), from the Edit menu, select Apply Deviation.
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Saving Current Curves As Targets
Use this option if you want to make your current printing response—that
is, the current curve—a target. Saving a current curve as a target curve is a
shortcut that lets you create the target curve without remeasuring the
sample you used to create the current curve. When you save a current
curve as target, the current curve is retained in the Harmony database.
To save a current curve as a target:
1.

Open the current curve you want to save as a target.
See Opening an Existing Curve on page 33.

2.

From the File menu, select Save Curve As.
Or:
Right-click to display the shortcut menu, and then select Save Curve
As.

The Save Current Curve As dialog box displays.

Figure 67: Save Current Curve As dialog box
3.

Click the Target Curve tab.

4.

In the Curve box, type a name for the target curve.

5.

Click Save.
The curve is saved as a target curve in the Harmony database.

Compensating for Undesirable High Density
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Compensating for Undesirable High Density
The Density Calibration option lets you compensate for an output device
that produces higher ink densities than you want by screening the solid tint
values produced by that device. This means you can match the solid
density of the target sample with the solid density of the current sample
when you create derived calibration curves.
For example, density calibration is useful if you have a high-density
proofing device and you want to reduce the density to match the lower
densities produced on press. Density calibration lets you achieve a better
match between proof and presswork.
You can calibrate density only if you select the Paper output type. For more
information, see Choosing Which Output Type to Calibrate on page 14.
Note: Density calibration compromises the halftone integrity of your output.

You cannot achieve dot-for-dot representation. Therefore, screening
effects, such as moiré, may not appear the same on final output.
Important: You can only calibrate density if your RIP can screen solid tints. For
more information, refer to your RIP documentation.

To calibrate density:
1.

Create the target curve and current curve that you want use to create
the derived calibration curve with density calibration enabled.
For more detail, see Creating Target Curves on page 45 and Creating
Current Curves on page 47.
Make sure you enter the solid density value— measured from your
sample tint bar—in the Solid Density box on both the Target Curve
and Current Curve windows.
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Enter the
solid density
value.

Figure 68: Target Curve window

For more information on measuring solid density, see Measuring Tints
on page 63.
2.

Create the derived calibration curve.
For more detail, see Creating Derived Calibration Curves on page 49.
The Calibration Curve window displays.
Harmony resamples
the curve when you
select Calibrate Density.

Figure 69: Calibration Curve window
3.

Select the Calibrate Density check box to enable density calibration.

Figure 70: Harmony warning box

Adjusting for Peak Density Below Solid Values
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If a warning box displays, you did not enter solid density values in the
Solid Density box on the Target Curve and Current Curve windows.
Or:
The target curve solid density value you entered is greater than or
equal to the current curve solid density value.
4.

If the warning box displays, click OK, and then enter or adjust values
in the Current Curve and Target Curve tabs on the Calibration Curve
window.

5.

Save the curve.

Note: If density calibration is enabled, Harmony uses the Murray-Davies formula
to resample the curve correctly; it does not simply scale the curve.

Adjusting for Peak Density Below Solid Values
In some situations, you may find that solid tints are less dense on the final
output than screened tints. Harmony lets you "cut back" or eliminate these
solids for target curves and transfer calibration curves.
For example, in flexography, solid tints on plate can actually produce lower
densities on the final printed output than screened tints. On a flexographic
plate, solid tint values carry less ink than screened values. This means a
lower tint value can actually achieve a higher density on press. Harmony
compensates for this by screening the solid tints.
Normally, you cut back your target and transfer calibration curve solid
tints if your output deliverable is Film or Plate. See Choosing Which Output
Type to Calibrate on page 14.
Note: Cutting back target and transfer calibration curve solid tints compromises
the halftone integrity of your output.

You cannot achieve dot-for-dot representation. Therefore, screening
effects, such as moiré, may not appear the same on final output.
Important: You can only cut back target or transfer calibration curve solid tints
if your RIP can screen solid tints. For more information, refer to your RIP
documentation.
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To cut back solid tints:
1.

Open the Target Curve or Transfer Calibration Curve window.

2.

In the Maximum Tone box, type the maximum tone value you want,
for example, 90.
This means that all tint values greater than 90 will be eliminated from
the curve.

Type the
maximum
tone value.

Figure 71: Target Curve window (solid cutback)
3.

Save the curve.

If you create a derived calibration curve using a target curve that has the
solids cut back, the derived calibration curve will inherit the maximum
tone value of the target curve. For example, if you create a derived
calibration curve using a target curve with a maximum tone of 90%, the
derived calibration curve will also have a maximum tone value of 90%.

Maximum tone
is cut back to
the value specified
in the target curve.

Figure 72: Calibration Curve window (solid cut back)

Eliminating Undesirable Highlight Tint Values
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Eliminating Undesirable Highlight Tint Values
Harmony lets you "cut off " or eliminate undesirable tint values in the
highlights of target and transfer calibration curves. You can use this feature
for any output type—film, plate, or paper.
Cutting off the highlights is especially useful if you make film or plates for
flexography. For example, you sell film to a customer who doesn’t want
dots smaller than a 5% dot on the film. Using the target and transfer curve
cutoff feature, you can eliminate any dots below 5% on the film.
Eliminating highlights on a flexographic plate is desirable because smaller
dots can actually produce higher densities than larger dots on the final
printed output. Fine dots on a flexographic plate can bend during the
printing process, rendering more ink on the paper than larger dots. These
undesirable dots in highlight areas are called scum dots.
To cut off highlight tints:
1.

Open the Target Curve or Transfer Calibration Curve window.

2.

In the Minimum Tint box, type the minimum tint value you want, for
example, 10.
This means that all tint values less than 10 will be eliminated from the
curve.

Type a
minimum
tint value.

Figure 73: Target Curve window (highlight cut off)
3.

Save the curve.

If you cut off the highlights of a target curve linked to a derived calibration
curve, Harmony will automatically apply the cutoff to the derived
calibration curve.
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Minimum tint
value is cut off
at the value
specified in the
target curve.

Figure 74: Calibration Curve window (highlight cut off)
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Using Densitometers
This section contains troubleshooting information about densitometers.

Absolute density is read instead of dot area
When measuring heavy tints (> 85%), some densitometers switch from a
dot area percentage reading to absolute density.
Solution:

Press the densitometer’s 0 (zero) key while holding the densitometer down.
If required, take the reading again.

Dot area > 100%
When measuring a tint that is less than the solid (100%) you defined, you
get a reading that is greater than 100%.
Solution:

The absolute solid reading was probably taken in a different area of the
press sheet than the tint bar. Redefine paper white and solid using the tint
bar to take the measurements.

Viewing Printed Results
This section contains troubleshooting information for problems with the
printed result.

Images don’t seem to be calibrated
One or more images on the press sheet don’t seem to have had the
calibration curve applied to them.
Solution:

Check to see if the image is pre-screened. If it is, calibration was not be
applied because the image has been previously RIPed by a different system.
See also the Harmony user documentation for your specific workflow.

If the image is not pre-screened, see Output using calibrated curve isn’t what
was expected.
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Number of impressions is severely shortened
On press, the impressions are degraded after only a small number of
impressions.
Solution:

Check the laser exposure value for your output device and set it to its
optimal setting. Traditionally, an output device’s exposure value can be
decreased to lighten the tints. This method cannot be used for computerto-plate technology. See Chapter 1, Overview.

Output using calibrated curve isn’t what was expected
The calibrated curve isn’t producing the output you expect.
Solution:

Measure the tints on the calibrated output. Do they match the target curve
values?
If yes, you are meeting the target you specified, but that target is not really
what you want. You need to select another target. See Selecting Your Target
Sample on page 60.
If no, the current curve is probably not correct.
You should first remeasure the tints on the current curve to make sure that
it is not a human or densitometer error. Is a measurement error found?
If yes, modify the current curve. See Chapter 3, Basic Steps for Creating
Curves.
If no, the current sample used is probably not indicative of how your
machinery (press, platesetter, or imagesetter) is performing. You should
take another current sample. See Creating Current Curves on page 47.
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Using the Harmony Graph
This section contains troubleshooting information about the Harmony
graph.

Red line appears in all or sections of the graph
The line of the graph is red in parts or all of the graph. Possible reasons for
the problem are:

•

The graph needs to be smoothed. See Smoothing Target or Current
Curves on page 73.
Or:

•

You are using the wrong view mode. See Polarity on page 39.

Can’t move curve in deviation mode
In deviation mode, the curve of the graph can’t be moved up or down even
though deviation nodes were added. A possible reason for the problem is
that there are no nodes on the graph. Nodes must be present on the graph
before deviation can be applied to them. In other words, you cannot create
a new curve without default nodes, and then immediately switch to
deviation mode.

Can’t create a calibration curve
If you create a derived calibration curve, or a transfer calibration curve of
derived origin, you must ensure that the output type, curve set type, or
measured colors (One Curve curve set only) of the target curve and current
curve you select match. If your settings don’t match, a Harmony warning
message displays. Sometimes the warning message prevents you from
creating the calibration curve. In this case, you must reselect a target or
current curve.
For information about appropriate curve set settings, see Matching the
Curve Sets on page 29.
For information about creating calibration curves, see Creating Derived
Calibration Curves on page 49 and Creating Transfer Calibration Curves on
page 54.
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File Menu

Figure 75: File menu

New Curve

Opens a new curve window.

Open Curve

Opens an existing curve.

Save Curve

Saves a curve. See Saving Curves on page 75.

Save Curve As

Saves changes made to a curve as a different curve.

Save All Curves

Saves all open curve windows.

Close Curve

Closes the open curve window.

Copy Curve

Makes a copy of a curve. See Copying an Existing
Curve on page 34.

Delete Curve

Deletes the selected curve from the Harmony
database. For more detail, see the Harmony reference
documentation for your specific workflow.

Import Curves

Imports curves from another calibration utility or
another Harmony database. See the Harmony
documentation for your specific workflow.

Export Curves

Exports curves to another Harmony database. See the
Harmony documentation for your specific workflow.

Exit

Exits Harmony.

Edit Menu
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Edit Menu

Figure 76: Edit menu

Polarity

Sets whether the curve displays in positive or
negative mode. See Polarity on page 39.

Snap Y to

Sets the decimal value that the node should jump
to when it is moved along the y axis. See Setting
the Snap-To Guide on page 37.

Curve Properties

Opens the Calibration Curve Properties dialog
box for the displayed curve. See Calibration
Curve Properties on page 85.

Convert to
Linear Curve

Removes all changes to nodes and changes the
curve back to a 45° curve with no nodes. See
Converting Nodes to a Linear Curve on page 36.

Convert to
Transfer Curve

Converts a derived calibration curve to a transfer
calibration curve. See Making Derived Curves
Transfer Curves on page 98.

Deviation Mode

Switches the curve to deviation mode. See
Deviating Curves on page 100.
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Apply Deviation

Saves the deviation applied to a curve. See
Deviating Curves on page 100.

Cancel Deviation

Cancels any deviations made since the last time
the deviation was saved. See Deviating Curves on
page 100.

Import Curve Profile

Imports a curve shape to a common file format.
For more information, contact your service
representative.

Export Curve Profile

Exports a curve shape to a common file format.
For more information contact your service
representative.

Preferences

Sets up your densitometer for automatic input.
See Setting Up Your Densitometer on page 40.

View Menu
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View Menu

Figure 77: View menu

Curve Tab

For a derived calibration curve, use to switch the
active tab among the Current, Target, Calibration, or
All Curves tabs.

Graph Type

Switches between viewing the graph in dot gain or
dot area mode. See View Dot Area or Dot Gain on
page 38.

Graph Grid

Sets the increments at which graph gridlines are
displayed: none, 1, 2, 5, or 10.

Curves Database

Display or hides the Curves Database window. See
Harmony Database Window on page 24.

Densitometer
Input

Displays the Densitometer Input dialog box. See
Taking Accurate Densitometer Readings on page 64.

Cursor Position

Displays the position bar. See Cursor Position on
page 31.

Toolbar

Displays the toolbar. See Toolbar on page 23.

Status Bar

Displays the status bar. See Status Bar on page 24.
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Window Menu

Figure 78: Window menu

Cascade

Arranges open windows in a cascade pattern.

Arrange Icons

Organizes any minimized icons.

Save Window
Defaults

Saves any changes made to the size of the curve
windows so that windows opened subsequently
default to this size.

Close All Curves

Closes all open curve windows.

Shortcut Menus
You can use your right mouse button to click any item and see a shortcut
menu. This menu contains common commands that you can use on the
item you clicked. For example, by right-clicking a curve in the Harmony
database window, you can open, copy, or delete it.

B

Toolbar
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Creates a new current curve. See Creating Current Curves on page 47

Creates a new target curve. See Creating Target Curves on page 45.

Creates a new derived calibration curve. See Creating Derived Calibration Curves on
page 49.

Creates a new transfer calibration curve. See Creating Transfer Calibration Curves on
page 54.

Opens an existing curve. See Opening an Existing Curve on page 33.

Saves the curve(s). See Saving Curves on page 75.

Displays the Calibration Curve Properties dialog box. See Calibration Curve Properties
on page 85.

Switches between normal curve entry and deviation mode. See Deviating Curves on
page 100.

Applies the deviation—that is, saves the curve in the new deviated shape. There is no
undo for this action.

Cancels any deviation done since the last time the deviation was applied.
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Displays or hides the Harmony database window. See Harmony Database Window on
page 24.

Use to automatically enter densitometer input to the curve. See Measuring Tints on
page 63.

Displays or hides the Cursor Position window. See Cursor Position on page 31.
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Connecting a Densitometer to Your Computer
This appendix provides step-by-step instructions for connecting a
densitometer to the computer on which Harmony is running.
Note: These instructions work for Windows 95 or Windows NT running on Intel
or Alpha computers. If you are running Harmony on a workstation with a RIP, be
careful to choose the port that is not being used to communicate with the output
device. If there are no free ports, install Harmony on another computer and
export the calibration curve to the workstation. See Exporting Curves on
page 92. Ideally, you should have this computer within comfortable range of the
table where you are taking densitometer measurements.

Much of the information in this appendix depends on the type of
measuring device you are using. For more information on setting up your
densitometer, see your densitometer documentation.

Serial Ports
Serial ports, or COM ports, are the connectors on the back of your
computer you use to attach a densitometer. Typically, a computer has two
serial ports that are identical in appearance:

•
•

COM1 refers to communication port 1
COM2 refers to communication port 2

25-pin serial port

9-pin serial port

Figure 79: Serial ports
Note: These serial ports are also referred to as serial port 1 and serial port 2, or
port 1 and port 2.

Extender Boards
If neither COM1 nor COM2 can be freed for attaching a densitometer,
extra COM ports can be installed on an extender board in your computer.
Extra COM ports will be called COM3, COM4, etc.
Note: This is more likely to be necessary if you are running your RIP as well as
Harmony on the same computer. They work fine together on the same computer,
provided you have the ports properly configured.

Connecting the Densitometer
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Connecting the Densitometer
Before connecting the densitometer to your computer, identify which port
number you will use by locating an inscription around the serial port, for
example, COM1 or COM2.
To connect the densitometer to your computer:
1.

Connect the cable that comes with your densitometer to the port you
will use.
Note: If the cable does not fit the COM port connector, contact your system
administrator because your computer may have nonstandard COM
connectors. In this case, your administrator should be able to provide an
adapter.

2.

Connect the other end of the cable to the densitometer.

Densitometer Data Interface Settings
Data interface settings specify the details for communicating with the
computer to which the densitometer is attached. For more information on
setting data interface settings, see your densitometer documentation.
Specify the following data interface settings for your densitometer.
Bits per second (or baud rate)

9600

Data bits

8

Parity

None

Stops bits

1

Flow control (or handshake)

None

Note: If your densitometer does not allow you to set all of the above settings,
set only the ones that are available.

Make sure the densitometer is configured to send its measurement data to
a computer. This is specific to the densitometer you use, but usually can be
done using a simple menu option. For details on sending measurement
data to a computer, see your densitometer documentation.
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Testing the Connection
Now that you have set the communications details on the densitometer,
you must configure the computer software to the same settings and test the
connection.
The best way to test the connection involves using a terminal program that
displays data transmitted over a COM port on the screen. Using a terminal
program, you can test the connection by checking whether data is sent to
the computer each time you take a measurement with the densitometer.
An example of a terminal program is Hyperterminal, available on
Windows 95 or Windows NT as an accessory.
To test the connection:
1.

Start the terminal program.
If you are using Hyperterminal, create a named connection, but do not
associate it with any modem.

2.

Select the COM port that your densitometer is connected to.

3.

Specify the COM port settings.
Use the exact settings specified in Densitometer Data Interface Settings
on page 127.

4.

If you are using Hyperterminal, click the Connect button in the
program’s toolbar.
Otherwise, skip this step.

5.

Take a measurement with the densitometer.
If the connection is good, you will see text displayed in the terminal
program’s window each time you take a measurement.
If text does not display in the terminal program’s window, see
Configuring Densitometers for Harmony on page 129.

Configuring Densitometers for Harmony
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Configuring Densitometers for Harmony
If Harmony is not preconfigured for your densitometer, you need to
specify the characteristics of your instrument in the densitomers.cfg file
located in the Harmony folder.
Configure the densitomers.cfg file by adding the following fields with the
appropriate information to the following line:
<Brand>|<Model>|<Cyan>|<Magenta>|<Yellow>|
<Black>|<Paper>|<Solid Cyan>|<SolidMagenta>|
<Solid Yellow>|<Solid Black>|
Note: For details on these fields, read the contents of the densitomers.cfg file.
For example, to configure an X-Rite 404 densitometer,
enter:
X-Rite|Model404|DOTTC|DOTTM|DOTTY|DOTTV|
None|None|None|None|None|
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Troubleshooting
This section describes problems you may encounter using a densitometer
with Harmony. It also provides possible causes and solutions for these
problems.

Densitometer
Problem:

If no data is transferred from your densitometer to Harmony, check the
possible causes listed below, then follow the appropriate solution.
Cause

Solution

Faulty cable

Make sure the cable you use is in good
working condition. If you used the cable
successfully to connect to other devices on
your computer, it is probably in good
working condition. If you are unsure about
the cable, ask your system administrator to
test the cable or give you a new one.

Improperly
connected cable

Make sure the cable connecting the computer
to the densitometer is firmly connected at
both ends.

Bad or improperly
configured COM
ports

If you are using a COM port on an extender
board, check the board’s documentation to
make sure the extra ports have been
configured properly. Test the port with other
devices or ask your system administrator for
help. If you determine that the COM port
hardware is bad, you will need to replace it or
try using another COM port that is working
properly.

Troubleshooting

131

Cause

Solution

Improper data
interface settings

Make sure the communication settings on the
densitometer and the computer are identical.
Review the settings on the densitometer and
terminal program and confirm that they are
set appropriately. For more information on
data interface settings, see Densitometer Data
Interface Settings on page 127.

Wrong COM port

If the ports on your computer are not
physically marked or the back plane is
inaccessible, try experimenting with your
terminal program by selecting all the COM
ports available, one at a time. Each time you
change the COM port in the terminal
program, run the connection test. If you are
using an Alpha-based computer, you must
restart the terminal program each time you
select a new COM port.

Faulty densitometer

After your system administrator has verified
that everything else is in working condition,
contact the densitometer manufacturer as a
last resort. (This problem is highly unlikely.)
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Harmony
Problem:

If your densitometer works with a terminal but not with Harmony, check
the possible causes listed below, and then follow the appropriate solution.
Cause

Solution

Wrong densitometer
selected

Make sure the densitometer you are using is
the same one you configured Harmony to
use. To configure Harmony for a
specific densitometer, select Preferences from
the Edit menu. See Setting Up Your
Densitometer on page 40.

Improper data
interface settings

Review the settings (on the densitometer and
in Harmony) and confirm that the settings
are identical.

Dot area only

Ensure the densitometer you use is
configured for dot area measurements. For
more information on configuring dot area
measurements, see your densitometer
documentation.

Absolute density is
read instead of dot
area

When measuring heavy tints (> 85%), some
densitometers switch from a dot area
percentage reading to absolute density.
To switch back to dot area reading, press the
densitometer’s 0 (zero) key while holding the
densitometer down. If required, take the
reading again.
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Cause

Solution

Dot area > 100%

When measuring a tint that is less than the
solid (100%) you defined, you get a reading
that is greater than 100%. This may be the
result of the absolute solid reading being
taken in a different area of the press sheet
than the tint bar.
To work around this problem, redefine paper
white and solid using the tint bar to take the
measurements.

134

Appendix C – Setting Up Your Densitometer

Glossary
amplitude
modulation
(AM) screening

See halftone.

calibrated data

A current sample that has had a calibration curve applied to it. If you use
calibrated data, you need to enter this information in Harmony, because
it affects the shape of any derived calibration curve that uses the current
curve.

calibrated tint

The tint value that Harmony substitutes for the tint specified in the
digital file to compensate for the current response. This lets you achieve
the target on the final deliverable.

calibration

Setting equipment to produce desired results.
See tonal calibration.

calibration curve

The curve that graphically represents how much Harmony needs to
compensate for tint values specified in the digital file when the file is
RIPed so that the target is achieved on the final deliverable.
In Harmony there are two types of calibration curves: derived and
transfer. Derived calibration curves are based on the target and current
curves you build. You adjust the derived calibration curve only when you
edit the target or current curve. Transfer calibration curves can be edited
directly because the curves are not linked to a target or current curve.
See derived calibration curve and transfer calibration curve.

characteristic

A profile of the output.

CMYK

Cyan, magenta, yellow, black. Colors for process color print production.
A calibration curve may be created for any color or specifically for each
process color. If process color-specific (CMYK) curves are used, then the
black curve is applied to all spot colors, unless you define spot curves. If
you define spot curves, spot colors are calibrated by those curves instead
of the black curve.
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color management

A process that aims to control the representation of colors across a variety
of output devices so that the colors generated appear consistent. Color
management is based on the coordination of three processes: device
calibration, device characterization, and conversion from one color space
to another.

color-specific
curves

The four unique curves—one for each process color (C, M, Y, and K)—
that are created when you use a CMYK Curves curve set in Harmony.
See curve set.

continuous tone image

An image that contains gradient tones.

current curve

A graphical representation comparing tint values specified in a digital file
and the measured dot area on a sample produced under specific
operating conditions. Current curves can be created from measured
samples produced by a device when it is uncalibrated or calibrated.

curve

A graphical representation of a set of numbered pairs. For current and
target curves, the numbered pair represents the tint specified in the
digital file compared to the measured dot area or tonal values on the
output.
For a calibration curve, the numbered pair represents the tint specified in
the digital file compared to the adjusted, or calibrated, tint that will be
substituted for the digital file tint during calibration.

curve set

The color separation(s) measured and used to build a calibration curve
in Harmony. Harmony has three types of curve sets: One Curve, CMYK
Curves, and Spot Curves.

densitometer

An instrument that uses a light-sensitive photoelectric eye to measure the
density of images and colorants. Densitometers often include
mathematical formulae that use density information to calculated other
image characteristics, such as contrast and tonal values (effective dot
area).

density

A measurement of the ability of light to pass through or reflect off a
material.
Density is measured using a densitometer.

density range

See tonality.
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A calibration curve that Harmony derives from the target and current
curve specified.
See calibration curve.

device

In the context of Harmony, device refers to hardware or software that is
used to process a job—for example, the Virtual Proofing System or a
Trendsetter.

dmax

See maximum density.

dot gain (loss)

On halftone output, the absolute percentage change in the actual
(physical dot gain) and perceived (optical dot gain) size of a halftone dot
as it goes through the halftone reproduction process. For example, 5%
dot gain means that 5/100 more light is being absorbed, regardless of the
tint that is being measured. In other words, 5% dot gain on a 1% tint
means an effective dot area of 6%; 5% dot gain on a 50% tint means an
effective dot area of 55%.
Dot gain happens during various phases of the halftone reproduction
process.
See effective dot gain, optical dot gain, physical dot gain, and tone value
increase.

dot gain calibration

See tonal calibration.

dot shape

The geometric appearance of a halftone dot—for example, elliptical,
round, or square.

dpi

Dots per inch. A unit of measurement that signifies the number of laser
dots that can be printed in an inch. The higher the number, the higher
the resolution of the output device.

effective dot area (EDA)

On halftone output, a measure of the percentage of light that is absorbed
by a given tint and that represents the tonal value as perceived by our
eyes. It is measured in absolute percentage, relative to the measured 0%
and 100% tints. Effective dot area is measured with a densitometer,
spectrophotometer, or any device that measures reflected or transmitted
light. Dot meters measure physical dot area, and should never be used to
measure effective dot area.
Effective dot area is also called tonal value.
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For halftone work, the difference between the tint specified in the digital
file and the effective dot area on the output. It is the sum total of all dot
gain in the halftone print reproduction process (both physical and
optical dot gain). It is expressed as an absolute percentage that is added to
the dot area or tonal value. For example, a 15% effective dot gain on 25%,
50%, and 75% tints results in 40%, 65%, and 90% tonal values.
See tone value increase.

file

A unit in which data is stored on a computer.

frequencymodulated (FM) screening

See stochastic screening.

gamut

The range of different colors that can be generated by a specific input
device, output device, or ink set.
See tonality.

gray balance

The values for C, M, and Y that produce a neutral gray with no dominant
hue.

halftone

The representation of text and visuals as dots within a grid. The grid,
called a screen, is composed of halftone cells. Each halftone cell is
composed of a group of laser dots which determine the size of the
halftone dot. The greater the number of laser dots imaged within the cell,
the darker the halftone dot. Halftone screening is also called amplitude
modulation screening.
See halftone screen.

halftone screen

On halftone output, the grid that contains the dots of halftone cells.
See halftone.

highlight

The lightest or whitest parts of an image.

imposition

Electronic imposition is the process of positioning the page elements and
whole pages in the file so that when the resulting press sheet is folded into
a signature, cut, and bound, the pages are in the correct sequence.

lpi

Lines per inch. The number of lines per inch in a screen grid. Also known
as screen ruling.
The greater the number of lines per inch, the sharper the image.
See ruling.
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maximum density

The density of a solid black patch is called the maximum density (or
dmax).

measured dot area (MDA)

The size of the dot on the medium as measured by the densitometer.

Murray-Davies dot area

See effective dot area (EDA).

Murray-Davies formula

The equation that calculates the effective dot area on halftone output by
comparing the light absorbing power of the tint to that of a solid.
For example, an effective dot area of 75% means the tint absorbs 75% of
the light that solid ink would.

native application
file

A file that has been created using a page layout application, such as
QuarkXPress.

node

A numbered pair value (x and y) on a graph. In Harmony, target and
current curves are created when you enter nodes on the curve graph.
See node set.

node set

A series of nodes on the Harmony curve graph. The line that connects the
nodes forms the profile of the curve.
You can specify a node set when you create a target or current curve. The
curve window opens with the node set displayed on the curve graph.
See also node.

OPI

Open Prepress Interface. A standard developed by Aldus which allows
high-resolution image data to be merged into a PostScript file. This
allows other programs that manipulate PostScript data at a larger
component level, such as pages, to deal with smaller amounts of raw data.

optical dot area

See effective dot area (EDA).

optical dot gain

The difference between the physical dot area and perceived effective dot
area of a dot.

paper white

0% tint.

PDF

Portable Document Format. Adobe System’s PDF is a reliable file format
for storing line art, images, and text (including all required fonts) for
pages. PDF files do not contain device-specific settings such as imaging
resolution or duplex options.
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physical dot area (PDA)

The physical size of the dot on a medium. The size of the dot as seen by
the human eye can be different from the physical dot area due to
additional effects of optical dot gain.

physical dot gain

The net change in the physical size of dots during the print reproduction
process, expressed as an absolute percentage of dot area. For example, a
2% physical dot gain at 25%, 50%, and 75% results in 27%, 52%, and
77% dot area, respectively. Physical dot gain only applies to halftone
devices.

PostScript

A page description language developed by Adobe Systems. It is used to
describe type and visual elements so that they can be output on devices
with PostScript interpreters.

print characteristic

The graphical relationship between the tint values specified in a digital
file, and the effective dot area or tonal values on a press sheet.

process control

In a manufacturing system, the way that products of the manufacturing
process are kept within certain acceptable limits of variation.

raster

Digitized (bitmapped) images defined pixel by pixel in rows and
columns. See also RIP.

reflection densitometer

A densitometer that measures optical density on paper or plate.The
measurement is based on the amount of light that bounces off the
medium back to the densitometer.

RGB

Red, green, and blue color model used by computer monitors to display
color.

RIP

Raster image processor. Software and/or hardware that converts digital
files into raster (bitmap) format for output on a given output device.

ruling

The number of lines per inch (lpi) on a halftone screen.
See lpi.

sample

The output from which measurements are taken to create a current or
target curve. The sample can be any output that contains a tint bar, such
as a press sheet, proof, plate, film.
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An image element with an even shading produced by a halftone dot
screen. Each screen is composed of rows of halftone cells. The size of the
dot within the halftone cell determines the tint.
Dot size is referred to by the percentage of the cell that it takes up, for
example, a halftone cell in which 50% of the cell is composed of laser dots
is called a 50% halftone.
See halftone.

screening

The process used to convert a continuous tone image—for example, a
photograph—into a halftone image. The halftone image is made up of
dots within a grid. The dots merge and give the illusion of a continuous
tone image.
See halftone screen.

scum dots

An undesirable film of ink that prints in highlight areas of the plate.

shadow

The darkest part of an image. On halftone output, shadows are
represented by the largest halftone dots.

solid

100% tint. An area of the image that has no halftones; it is an unbroken
film of ink.

spot color

An ink color that is not a process color (C, M, Y, or K). Spot colors are
used primarily to render an accurate smooth tint, often with a color that
lies outside the gamut of process color inks.
Harmony lets you create specific calibration curves for spot colors.

stochastic screening

A digital screening process that converts images into very small dots of
equal size and variable spacing. Also called frequency-modulated (FM)
screening.

target

An output sample that you use to match tonal reproduction.

target curve

A graphical representation of tints specified in the digital file and the
measured dot area for your optimal or desired output.
Harmony comes with default target curves including industry standards
for print, film, and plate output. You can also import predefined target
curves from the CreoTargets.hmy and, if you have a Spectrum proofing
device, the ImationTargets.hmy files.

142

tint

Harmony User Guide

For Harmony, tint is the percentage value assigned to a dot.
See screen tint.

tint bar

Test marks included in an output sample. A tint bar consists of series of
ink patches for tint values, ranging from a 0% tint to a 100% tint, on an
individual color separation. The samples you use to create current and
target curves must include tint bars so that you can accurately measure
tints.

tonal calibration

Setting equipment to reproduce tonal values to specified values on your
final output (for example, a proof, press sheet, or plate).
Harmony compensates for tonal value increase by adjusting the size of
dots imaged on the plate, digital halftone proof, press sheet, or film.
Harmony compares the difference between a target and a current sample
and determines the adjustment needed to tint values specified in the file
to achieve the target output.

tonal range

See tonality.

tonal reproduction

Perceived tint.

tonal value

The sum total of all absorbed light for a given tint, regardless of the
reproduction technology (halftone or continuous tone).

tonality

The degree of lightness as perceived by our eyes. It is measurable with
instruments that measure reflected and/or transmitted light. The depth
of tonality in an original image or reproduction is the range of
perceivable tones; this is also called the density range, gamut, or tonal
range.

tone value increase

The difference between the tint specified in the digital file and the tonal
values on the output. Tonal value increase is the sum total of all increases
in tonal values that can happen at various stages of the print
reproduction process.
See effective dot gain.

transfer calibration curve

A calibration curve that is not linked to a target and a current curve. A
derived calibration curve may be converted to an transfer calibration
curve. This is usually required only when you need to fine tune a curve
without affecting current or target data.
See transfer calibration curve.
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transmission densitometer

A densitometer that measures the optical density of film. The
measurement is based on the amount of light transmitted through the
film without being absorbed or scattered.

Yule-Nielson factor

An equation that alters the measurement of a densitometer to measure
physical dot size rather than effective dot area. Often used with
traditional plate densitometry.
Do not use the Yule-Nielson factor when calibrating with Harmony, even
when calibrating to plate. If your densitometer has a Yule-Nielson rating
level, leave it set to 1 and do not adjust it while taking measurements.
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Index
A
accurate samples, getting, 62
adding node sets, 35
adding nodes, 35
adjusting curves, 100
application window overview, 22
attention symbol, xiii
automatic densitometer input, 64

B
benefits of Harmony, 2

C
calibrated data
using, 84
calibrated tint, 11
calibrating density, 105
calibration
See tonal calibration.
calibration curve
converting derived to transfer, 98
creating a derived, 49
creating a transfer, 54
derived, 26
how Harmony creates, 11
how many to create, 14
overview, 26
properties, 85
testing a derived, 53
transfer, 26
CMYK Curves set, 27
color-specific curves
attaining gray balance, 96
overview, 12
comments about manual, xiii
connecting a densitometer, 127
convert to linear curves, 36
copying curves, 34
creating names
for calibration curves, 86
for current curves, 81
for target curves, 79
creating nodes, 35
CreoTargets.hmy, 26, 45, 60, 92

current curve
creating, 47
overview, 26
properties, 80
saving as a target, 104
current response
calibrated, 84
current sample
obtaining, 61
cursor position, 31
curve
exporting, 92
importing, 94
importing and exporting, 92
modifying properties, 89
naming, 30
properties, 78
smoothing, 73
spotting problems, 73
types, 25
curve database
copying from, 34
opening a curve, 33
curve graphs, 34
curve sets
changing, 99
matching, 29
overview, 27
setting for current curves, 82
setting for target curves, 79
curve window
graphs, 34
overview, 30
cutting back solid tint values, 107
cutting off highlights, 109

D
database
copying curves from, 34
opening a curve from, 33
overview, 24
database window, 24
deleting
all nodes, 36
individual nodes, 35

densitometer, 16
auto input, 64
configuring for Harmony, 129
connecting, 127
ensuring accurate readings, 64
measuring tints, 63
reflection, 16
setting the Yule-Nielson rating, 16
setting up, 40
strip reader input, 64
transmission, 17
troubleshooting, 112
density calibration, 105
derived calibration curve, 26
converting to transfer, 98
creating, 49
deviating curves, 100
dot area
viewing on graph, 38
dot gain, 3, 7
removing, 9
viewing on graph, 38
dot meter, 17
dragging nodes, 37

E
EDA
See effective dot area.
Edit menu, 117
effective dot area, 5, 7, 16, 32
existing curve
copying, 34
opening, 33
exporting curves, 92

F
File menu, 116
film calibration, 14
film, negative, 39

G
getting accurate samples, 62
graph, 34
turns red, 73
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H
hardware requirement, 16
Harmony
application window, 22
benefits, 2
defined, 2
starting, 22
Harmony database
importing and exporting curves,
92
Harmony database window, 24
hide
Harmony database, 25
position bar, 31
status bar, 24
toolbar, 23
highlights
eliminating, 109

I
ImationTargets.hmy, 26, 45, 60, 92
importing curves, 94

L
limitations of tonal calibration, 3

M
manual
sending comments, xiii
matching curve sets, 29
MDA
See measured dot area.
measured dot area, 32
measuring device, 16
dot meter, 17
reflection densitometer, 16
spectrophotometer, 17
strip reader, 17
transmission densitometer, 17
measuring samples, 63
menu
right-click, 23
shortcut, 23
menu bar, 23
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mode
deviation, 100
modifying curve properties, 89
moving nodes, 37
Murray-Davies dot area, 5

N
naming
calibration curves, 86
current curves, 81
of target curves, 79
negative mode, 39
neutral gray
getting, 96
node set, 35
node sidebar, 32
nodes
adding, 35
converting to linear, 36
creating, 35
deleting, 35
moving, 37

O
One Curve set, 27
opening
curves, 33
Harmony, 22
operating conditions, 3
operating system requirement, 16
optical dot gain, 7, 8
other calibration tools
how Harmony compares, 2
output type
selecting, 14, 60

P
paper calibration, 14
PDA
See physical dot area.
peak density
below solid values, 107
physical dot area, 32
physical dot gain, 7, 8
plate calibration, 14
plates, negative, 39
polarity, 39

setting for target curves, 79
position bar, 31
positive mode, 39
predefined targets, 26, 45, 60, 92
preferences, 40
pre-screened data, 3
print characteristic, 7, 11
properties
calibration curve, 85
current curve, 80
names of target curves, 79
naming calibration curves, 86
naming current curves, 81
target curve, 78

R
redoing curves, 36
reflection densitometer, 16
removing nodes, 35
right-click menus, 23

S
sample
calibration applied, 84
saving
current curves as targets, 104
curves, 75
read-only target curves, 76
scum dots, 109
selecting
output type, 60
targets, 60
setting curve properties, 78
setting the Yule-Nielson rating, 16
setting up a densitometer, 40
shortcut menu, 23
sidebar
node, 32
smoothing curves, 73
snap-to guide, 37
solid density, 72
solid tint values
cutting back, 107
spectrodensitometer, 17
spectrophotometer, 17
Spot Curves set, 27
standard toolbar, 23

Index
starting Harmony, 22
status bar, 24
strip reader, 17
strip reader input, 64

T
taking measurements, 63
target curve, 10
creating, 45
overview, 26
properties, 78
targets, 2
selecting, 60
using predefined, 26, 45, 60, 76,
92
using your own, 61
testing derived calibration curves, 53
theory of tonal calibration, 5
tint
measuring, 63
tint bar, 19
tonal calibration, 3
limitations, 3
theory, 5
tonality, 5
tone value increase, 5
toolbar
standard, 23
tools required, 16
transfer calibration curve, 26
converting to, 98
creating, 54
transferring curves to another
database, 92
transmission densitometer, 17
troubleshooting, 112
type of output
selecting, 60
type of output to calibrate, 14
types of curves, 25

U
undesirable high density
compensating for, 105
using calibrated data, 84
using Harmony
overview, 10
using negative plates or film, 39
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V
view
cursor position on graph, 31
graph as dot gain or dot area, 38
Harmony database, 25
status bar, 24
toolbar, 23
View menu, 119

W
what is Harmony, 2
why calibrate, 3
Window menu, 120

Y
Yule-Nielson rating, 16

148

Harmony User Guide

www.creo.com

